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Software License Agreement

This AccuSoft software product ("Product") is a proprietary and copyrighted Product of Schellenbach &
Associates, Inc. dba AccuSoft Enterprises ("ASE"). It is licensed (not sold) to you, and you may use this
Product only on the terms of this license from ASE, even though you may have obtained the Product from
a dealer or other source.

License
ASE grants you a non-exclusive license only to:

1. If you have purchased a Single User License as indicated by the Product media label, you may use
the Product on one computer or thin-client terminal which you own or use. A Separate license is
required for use on each other computer or thin-client terminal on which the is Product used. But,
you may transfer the product to another computer if it is a replacement for the original computer or if
the original computer is inoperable due to a malfunction, until it is repaired.

2. If you have purchased a Small Business License, you may use the Product on a limited number of
computers or thin-client terminals which your Company owns or uses (seats). The number of seats
you are authorized to use the product on is 50, unless otherwise designated on the Product media
label. Additional seats are available for additional cost. However, the seat limit will not apply if every
computer or thin-client terminal on which the Product is used is located in a single building,
facility, or campus.

You may make copies of this Product as necessary to use the Product with other Computers owned
or used by your Company as long as the seat limit is not exceeded.

A separate license is required for use by any affiliate of your Company.

3. merge the Product with other applications which utilize the Product. This license will remain effective
as to any merged portion of this Product.

4. make one copy of the Product for archival or backup purposes in support of your use of the Product.

5. transfer the Product and this license to another party if the other party agrees to accept the terms
and conditions of this Agreement. If you transfer the Product, you must at the same time either
transfer or destroy all copies, including any portions of the product merged into other programs or
stored on computer memory devices such as hard disks. IF YOU TRANSFER POSSESSION OF
ANY COPY OR MERGED PORTION OF THE PRODUCT TO ANOTHER PARTY WITHOUT
TRANSFERRING THE PRODUCT ITSELF AS PROVIDED HERE, YOUR LICENSE IS
AUTOMATICALLY TERMINATED.

Except as otherwise provided in this agreement, you have no right under this license to rent, lease,
transfer, or distribute the Product. You may use the Product in object code form only.

Title

Title and copyright to the Product, including the Product media and documentation, remain with ASE. You
are not the owner of this Product, but you have the right to use it in accordance with this license. You are
not licensed to copy, reproduce or make data transmissions, in whole or in part, of the Product, except as
is permitted in this license. You agree not to modify, reverse engineer, translate, disassemble or
decompile the Product, in whole or in part.

License Term

The license is effective upon opening of the Product package or use of the Product and shall continue until
terminated. You may terminate it at any time by destroying the Product together with all copies and the
Product Documentation. THIS LICENSE WILL TERMINATE AUTOMATICALLY IF YOU FAIL TO COMPLY
WITH ANY TERM OR CONDITION OF THIS LICENSE. Upon termination you agree to destroy the
Product, the Product Documentation and all copies, purge the Product from all computers and memory
devices such as hard disks, and eliminate the Product from any merged programs.

Limited Warranty

ASE warrants that for a period of six (6) months from date of purchase the Product will perform according
to the specifications set forth in the associated Product Documentation and the diskette (or other medium)
on which the Product is located will be free from defects in materials and workmanship under normal use.

YOU ASSUME THE RESPONSIBILITY FOR THE SELECTION OF THE PRODUCT TO ACHIEVE YOUR
INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE




PRODUCT. ASE does not warrant that the functions contained in the Product will meet your requirements
or that the operations of the Product will be uninterrupted or error free, or will function properly in every
hardware environment. This warranty gives you specific legal rights and you may also have other rights
which vary from state to state.

EXCEPT AS EXPRESSED HEREIN, THE LICENSED PROGRAM IS PROVIDED TO YOU "AS IS". ASE
DISCLAIMS TO THE FULLEST EXTENT PERMITTED BY LAW ALL OTHER WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHICH SHALL IN NO EVENT
EXCEED ONE YEAR. Some states do not allow the exclusion of implied warranties so the above
exclusion may not apply to you.

No person is authorized to modify the warranties contained in this license or make any different warranty
for the Product.

Limitations of Remedies
ASE's entire liability and your exclusive remedy shall be limited to:

1. the replacement of any Product, including its diskette or other medium, that does not meet the
standards of the limited warranty above. To use this warranty, you must return, at your expense, the
Product and all copies along with a copy of your purchase invoice and a brief description of the
defect to AccuSoft Enterprises, Customer Service Dept., 8041 Foothill Blvd., Sunland, CA 91040.
Upon verification of the defect, ASE will send to you, at ASE's expense, a replacement Product.

2. if ASE is unable to deliver a replacement which is free of defects, ASE will refund your purchase
price.

IN NO EVENT WILL ASE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS,
LOST SAVINGS, LOST DATA OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PRODUCT EVEN IF ASE OR ANY OF ITS DEALERS
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY
OTHER PARTY. ASE'S MAXIMUM LIABILITY SHALL IN NO EVENT EXCEED THE PURCHASE PRICE
YOU PAID FOR THE PRODUCT. Some states do not allow the limitation or exclusion of liability for
incidental or consequential damages so the above limitation or exclusion may not apply to you.

Customer Registration

ASE may from time to time revise and update its Product or provide useful customer information. You may
wish to know about Product improvements and the availability of upgrades. To obtain this useful service,
you must fill out and return the enclosed customer registration card. ASE urges you to do so immediately.

General

You may not sublicense, assign or transfer this license or the Product to any other person or entity except
as expressly allowed in this license. Any attempt to sublicense, assign or transfer is void.

This Agreement will be governed by laws of the State of California, exclusive of its choice of law
provisions.

You further agree that this is the complete and exclusive statement of the agreement between us which
supersedes any proposal or prior agreement, oral or written, and any other communications between us
relating to the subject matter of this agreement.

If any provision of this agreement shall be held to be invalid, illegal or unenforceable, the remaining
provisions shall not be affected.

If you have any questions concerning this license, you should contact AccuSoft Enterprises, Customer
Service Dept., 8041 Foothill Blvd., Sunland, CA 91040, USA.
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INTRODUCTION

Welcome to AccuTerm 2K 2 — MultiValue Edition. We've worked hard
to give you the fastest and most accurate terminal emulation package on the
market. We have also tried to make it easy to use. Our philosophy has been
to add the features that will bemost useful without sacrificing ease of use,
accuracy or performance.

This User Guide is intended to help you install, configure and use
AccuTerm 2K2. A separate Programmers Guideis available, and it includes
information on programming AccuTerm, control codes escape sequences,
scripting, ActiveX/OLE features, the GUI devel opment environment and
Windows/host integration.

Featuresof AccuTerm 2K ?2

Multiple sessionsusing M DI (Multiple Document Interface). This means
that you can run two or more terminal sessions at the same time without
running two copies of AccuTerm It works the same as other programs that
allow you to work with more than one document at atime like word
processors, spreadsheets, etc. so it’s easy to work with. Y ou don’t have to
learn anew way of working. Also, by using MDI instead of running
multiple copies of AccuTerm, you use less system resources and memory.
You can still run multiple copiesif you choose, we just think MDI works
better.

User interface has Office 2000 look and feel, including context menus
accessed by clicking with the right mouse button. The new toolbar can be
hidden completely and also features balloon help that shows you what the
buttons mean. Toolbar, menu, session bar and status bar can be customized
by the user.

Full OLE Automation / ActiveX support alows integration with other
Windows applications. AccuTerm 2K 2 acts as both automation client and
automation server. AccuTerm exposes its application and session objects,
which allows other applications complete control of AccuTerm.
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ActiveX component (OCX) terminal emulation & communications engine
may be used in custom VB applications where accurate terminal emulation
is required.

Secur e Shell connections ensure privacy using public key encryption
technology. SSH1 and SSH2 protocols are supported, and several ciphers
are available.

Accur ate emulations When you use AccuTerm everything will work just
like the terminal being emulated. No strange problems with word
processors or spreadsheets. No messed up screens. No hassles.

M odem connections use Windows built-in dialer, and unlimited phone
directory entries.

Fast File Transfer capabilities using industry standard protocols like
Xmodem, Y modem, Zmodem, and Kermit. MultiValue file transfer wizard
and utilitiesimport and export MultiValue datain a variety of formats. And
direct Host-to-Host file transfer, too!

Scripting language and macr o recor der allows users to record macros or
write scripts using Visual Basic for Applications (VBA).

Enhanced scroll back window saves up to 10,000 lines for instant recall.
Extended screen support of up to 240 columns by 240 rows.

Automatic font scaling so that you can always see the full screen. Thisisa
great feature. Once you get used to it, you'll never want to go without it!

Enhanced network support for Telnet , Secure Shell (SSH1 & SSH2) and
PicLan.

GUI Development Environment helps you build user-friendly GUI front-
ends for your MultiValue applications.

Tabbed setup screensefficiently organize settings and preferences.

Image and sound support lets you to display images anywhere on the
terminal screen. Y ou can also play Wave and MIDI sound files.

WED Windows based program / data editor includes BASIC syntax
highlighting in an MDI environment.

2 Introduction



Tektronix graphicsterminal emulation in both color and monochrome.

Visual Stylesand full color mappinglets you choose any foreground and
background color combination for any terminal visual attribute, and attach a
border effect to the attribute. Application of Visual Styles can give
character-based applications an instant facelift!

Easy to use. AccuTerm follows the Windows Interface Application Design

Guide more closely than many other terminal emulation programs. This
makes AccuTerm easier to learn and use.

Har dwar e and Softwar e Requirements

Memory: 128MB

Processor: Pentium3-500 or better

Windows: 95, 98, ME, NT 4.0, 2000, XP, 2003, Vista

COM nport: Any serial port, modem or network adaptor supported by
Windows

Mouse: Any mouse supported by Windows

Note: in order to open a Secure Shell connection, you must have 128 bit
encryption installed in Windows. To check Windows encryption, open
Internet Explorer and select “About Internet Explorer” from the Help menu.
If the Cipher Strength isless than 128 bits yau will need to either upgrade to
Internet Explorer 6.0 (or above) or install the High EncryptionPack for your
version of Internet Explorer. Search Microsoft’s web site for “High
Encryption” for more information. In order to use the AES cipher with
Secure Shell, you need to be running Windows XP or higher.
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GETTING STARTED

This manual assumes that you have a working knowledge of the Windows
environment. If you are new to Windows, there are many good books
available. They do a much better job of explaining the basics than we could
do in this manual .

Installation

Toinstall AccuTerm 2K2, insert the AccuTerm 2K2 program CD and click
the “Install AccuTerm 2K2 Standard Edition” button when the startup
screen is displayed. If the startup screen does not display, select “Run” from
the Start Menu, and enter “ D:\Autorun.exe” in the “Open” text box, then
click OK (change D: to the letter for your CD drive).

1)

2)

3)

The AccuTerm 2K2 installation wizard will guide through the
installation process. Y ou will be prompted to enter your
authorization key, registration information, select the
destination directory and select a start menu program folder.

Y ou move forward through the installation process by clicking
the Next button. Y ou can click theBack button to move back,
or the Cancel button to cancel the installation.

Thefirst item you need to enter isyour Authorization Key.
Enter each half of the key into a separate box. Click Continue
after you have entered your key. Do not enter anything in the
Custom code box unless your dealer has given you a custom
code. After clicking on the Continue button, the software
license agreement will be displayed. Y ou can scroll through
text of the license and if you accept the license terms, click the
OK button.

The Welcome dialog is displayed. Click the Next button.
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4) The Registration I nformation dialog box is displayed. Please
enter the user, company and location in this dialog, then click
the Next button. Depending on your software license, some
fields may not be displayed.

5) Select the directory where you want the AccuTerm program
filesto beinstalled, then click theNext button. The default
installation directory is C:\Program Files\Atwin.

6) Selecta“home” directory. The default “home” directory isthe
current user’'s “My Documents’ directory. Thisisthe directory
where AccuTerm will start from when using Open and Save
for reading and writing session configuration files. After

selecting the “home” directory, click theNext button.

7) Choose whether you want files which are replaced during
installation to be saved in a backup directory. If you select this
option, when you click the Next button, you can select the
directory where replaced files are saved.

8) Select a“Start Menu” folder for the AccuTerm 2K2 shortcut.
If you would like a shortcut to AccuTerm 2K 2 placed on your
desktop, select the “Place shortcut on desktop” option. If you
want the shortcut to be available to all users of the PC, select
the “Make shortcut available to all users’ option. Click the
Next button.

9) Tobegininstaling files, click theNext button. The installation
progress will be displayed.

10) Some features of AccuTerm 2K 2 utilize the Microsoft Data
Access Objects (mainly importing and exporting data to and
from Microsoft Access databases). If you do not aready have
version 3.5 (or higher) of the Microsoft Data Access Objects
installed on your computer, you can select to have these
componentsinstall at thistime. A system reboot will be
required during this installation.

11) When theinstallation is complete, you can view the release
notes by checking the “View release notes’ box, and clicking
Einish. If you do not want to view the release notes at this
time, simply clear the “View release notes’ box and click
Finish.
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During installation, you may get a message indicating that the OLE or
system files are in use and need to be updated. If this oacurs, please shut
down all other applications, then click theOK button to restart Windows.
After Windows restarts, the installation process will resume (if it does not
resume automatically, simply start the installation over again; this time the
OLE or System files should have already been updated and you will not get

this message again.)

Network | nstallation

If you have a network and are installing aSmall Business Licenseor
Enterprise License version of AccuTerm, you can copy the “ Atwin2K?2"
folder from your installation CD to a network share. You can then install
AccuTerm on any workstation that has access to the network share by
navigating to the shared Atwin2K 2 folder and doubleclicking on the
atw2k253a.exe file name.

Even if you areinstalling AccuTermfrom a network, you still must install it
on each workstation. Thisis because some files are installed in nonshared
directories such as WINDOWS and WINDOWSSY STEM.

Some aspects of the installation process can be custamized. Please see the

“Custom Features’ topic in the AccuTerm Programmers Guide for more
details.

Activating an evaluation ver sion

To activate an evaluation version of AccuTerm 2K 2 after obtaining an
authorization key (or CD key), you need to re-install the program. Y ou do
not need to un-install the program first. Simply re-install, and enter the key
when prompted.
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Per sonal Edition limitations

AccuTerm 2K2 Personal Edition isafree, non-commercial, version of
AccuTerm 2K 2 for educational purposes. It includes all standard AccuTerm
2K 2 features except that connections are restricted to “localhost”

(127.0.0.2) only. Also, alocal version of a supported MultiValue database
must be running on the same system. For a current list of supported
platforms, click on the Personal Edition link from the Products page on
www.asent.com.

Running AccuTerm 2K 2

AccuTerm 2K 2 uses the Windows M DI (Multiple Document I nterface)
standard for handling more than one session. 1t works the same as other
popular Windows applications like Microsoft Excel and Microsoft Access,
except that instead of opening workbooks or tables, you open termiral
session configuration files. Each configuration file that you open becomes
one session. Normally, terminal session configuration files are saved with
the .atcf extension.

To run AccuTerm 2K 2, simply select |8l scautem2k2 | from the Start

on the desktop. AccuTerm’s main

window will be displayed. At the start, AccuTerm shows a blank
workspace, menu and toolbar. Any terminal sessiors you create or open
are displayed in the workspace. Most menu and toolbar functions are
disabled at this time because no terminal sessions are open yet.

menu, or click the AccuTerm icon

Thefirst time you run AccuTerm 2K 2 you will be prompted to create a
new terminal session using theConnection Wizard. To create a session,
click the Y es button at thistime. Y ou can always create a session at later
time by choosing New from the Eile menu.

Creating a New Session
After starting AccuTerm, you can use theConnection Wizard to guide you
through the process of creating a new session. To start theConnection

Wizard, select New from the File menu or click the[ [] | button on the
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toolbar. When the New Connection dialog isdisplayed, click the
Connection Wizard button to start the wizard, then follow the step by step
instructions for creating a new session. If you prefer to configure the
terminal settings manually, click theCustom Settings button instead.

When a session has been opened, it occupies some (or al) of the workspace.
Several sessions may be open at the same time, and they share the
workspace. The session windows can be cascaded or tiled, or may occupy
the entire workspace.

Shortcuts

Y ou can also create a shortcut to any session configuration file (or layout
file) by dragging the file from Windows Explorer and dropping it on the
desktop while holding the CTRL + SHIFT keys. When you double-click the
shortcut to an AccuTerm session or layout file AccuTerm will automatically
load that file when it starts.

Note: to load a layout and run a script, open the layout file load the script,
then save the layout. Create a shortcut to the layout file name as described
above. When opening the layout file, first all session files contained in the
layout will be opened, then the script’s Main subroutine will be run.
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AccuTerm Main Menu

EileMenu

The AccuTerm Eile menu contains options for creating, opening, closing
and saving a sessions, and printer setup and control. Common menu options
may also be executed by clicking a button on the toolbar.

FEile New
To create anew terminal session, select theNew option or click the
[ | button on the toolbar. The New Connection dialog will be

displayed. Select Connection Wizard to use the connection wizard
to help you build a new session, or select Custom Settingsto
create a new session and enter the settings yourself.

Eile Open...
To open an existing session configuration file, select theOpen

]

option or click the| =z button on the toolbar. This creates a new

session with the settings saved in the selected configuration file.

EileClose

To close the active session, select theClose option. If you have
made any changes to the session settings, you will have the
opportunity to save them in a session configuration file before
closing the session.

Eile Saveand File Save As...
After adjusting session settings, save the new settingsin a
configuration file by selecting the Save or Save As option, or by

clicking the| [ | button.

Eile SaveL ayout and File Save Layout As
If you have several sessions open, you can save them as a group, or
layout, by selecting the Save Layout or Save L ayout Asoptions.

Eile Printer On

Selecting this option toggles the slave printer on and off. When
the slave printer is on, received datais printed on the selected
printer and displayed on the terminal screen. You can also press
ALT + P to toggle the slave printer state.

10
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Eile Print Screen
Selecting this menu option or clicking the button causes the

current terminal screen to be printed on the selected printer. You
can also pressALT + G to print the terminal screen.

Eile Print Setup...
Select this option to set up printer information. See the section on
“Printer Selection” in the next chapter for details.

Recent files

Opens one of the most recently opened terminal session
configuration or layout files. By default, the last four files are
shown. The number of files to show is customizable (see “ General
Settings’ in the next chapter).

Eile Exit
Select this option to terminate AccuTerm 2K2.

Edit Menu
The AccuTerm Edit menu contains commands to copy and paste from the
Windows clipboard and select the screen.

Edit Copy

This command will copy a selected block of text from the terminal
screen to the Windows clipboard. If there is no selection, the entire
screen is copied. To select ablock on the screen, position the
mouse on the upper left corner of the desired block. Pressand hold
the left mouse button for about one half second, then drag the
mouse to the lower right corner, and release the button. The
selected areawill be indicated by a dotted rectangle. To remove
the selection, click the left mouse button anywhere on the screen.

If the screen needs to be scrolled to select the desired data, move
the mouse to the edge of the window and the window will

automatically scroll in that direction. You can aso click the
button to copy the screen or selection to the clipboard.

Edit Paste
This command will send the clipboard contents to the host
computer. Each lineisterminated as specified in the ASCII file

transfer settings (see Miscellaneous Settings). Clicking the ([,
button will also perform this function.
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Edit Paste Erom...

This command will send the contents of atext file to the host
computer. A file selection dialog box will be opened when you
select this command.

Edit Select Screen
This command will select the entire screen. Y ou will see a dotted
rectangle around the selection.

Edit Select All
This command will select the entire screen and history. Y ou will
see adotted rectangle around the selection.

Edit Select None
This command will remove any selection and erase thedotted
rectangle.

View Menu
The AccuTerm View menu contains options to select screen size, display or
hide the toolbar, status bar and session bar.

View Extended Screen Size

Toggles the screen size between Normal (usually 80 columns by 24
rows) or Extended (usually 132 columns by 24 rows) size. See
“Screen Settings” for information on setting the number of columns

and rows. The screen size may also be changed by clicking the
—

=y | button.

View Toolbar
Check this option if you want the toolbar displayed in AccuTerm’'s
main window. Un-check this option if you want the toolbar hidden.

View Status Bar

The status bar displays information about the current session:
keyboard state, cursor position, screen size, terminal type, printer
status, capture status, connection type and connection status. Check
this option to display the status bar at the bottom of AccuTerm’'s
main window. Un-check this option if you do not want the status
bar displayed.

12
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View Session Bar

The session QuickBar is used to quickly navigate between multiple
sessions. It is similar to the Windows taskbar. Every session has a
button on this bar and clicking on the button activates that session.
Check this option if you want the session bar displayed at the
bottom of AccuTerm’s main window. Un-check thisoption if you
do not want the session bar displayed.

View Function Bar

The function bar is used to display arow of function key buttons at
the top or bottom of the session window. These buttons perform the
same action as the twelve function keys on the keyboard. The first
button in the bar is the bank selector. Click this button to select the
active function key bank from a small popup menu: normal, shift,
ctrl or shift+ctrl. The default function key button captions are
simply F1 ... F12, however, the captions may be customized in the
Keyboard tab of the Settings dialog. The General tab of the
Settings dialog provides options to select the bar position (top or
bottom) and display the key number in the corner of each button.
Un-check this option if you do not want the function bar displayed.

ToolsMenu

The Tools menu contains options for modifying AccuTerm’s settings,
dialing a number, initiating file transfers and data capture, recording a
macro and opening the script window. Each of these options opens a dialog
box where the desired function is performed. See the appropriate sectionin
this manual for details on each function.

Tools Settings...
Select this option or click the button to open the Settings

dialog box. Thisdialog is used to modify al of AccuTerm’'s
settings and preferences, such as communications device, terminal
type, screen colors, etc.

Tools Customize Menu...

Select this option to open the AccuTerm Menu Designer, which is
used to customize the menu, toolbar, status bar and session bar.
For information on customizing the menu and toolbar, see the
“Customizing the Menu and Toolbar” chapter in the AccuTerm
Programmers Guide.
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ToolsDialer ...

Select the Dialer option to enter or choose a phone number to dial
when using a Modem connection. Also choose this option to
disconnect a Modem connection. Note: this option will be disabled
unless the connection typeis“Modem”. Y ou can quickly call up

the Dialer dialog by clicking the|'# | button on the toolbar.

Tools Upload

Selecting this option displays theFile Upload panel. Select

Upload Wizard if you are connected to a MultiValue host system
and want to use the File Transfer Wizard to guide you through the
upload process. Select M anual Upload to open the AccuTerm
File Upload dialog box, where you can select filesto upload, select
atransfer protocol, initiate an upload and specify other options.

Y ou can quickly call up theFile Upload dialog by clicking the

&4 | button on the toolbar.

Tools Download

Selecting this option displays the File Download panel. Select
Download Wizard if you are connected to a MultiValue host
system and want to use theFile Transfer Wizard to guide you
through the download process. Select M anual Download to open
the AccuTerm File Download dialog box, where you can select
the destination download directory, select atransfer protocol,
initiate a download and specify other options. Y ou can quickly call

up the File Download dialog by clicking the| T&] | button on the

toolbar.

ToolsCapture...

Selecting this option displays theBegin Captureor End Capture
dialog box. Use the Begin Capturediaog to select the destination
file and specify other options. Use theEnd Capturediaog to
terminate the capture operation. Y ou can quickly call up the

Capture dialog by clicking the button on the toolbar.

ToolswED Editor...

AccuTerm 2K 2 includes a Windows based text and program editor
designed specifically for MultiVaue users. If you are connected to
aMultiVaue host, you can access thewED editor by selecting this

menu option or clicking the button on the toolbar.

14
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ToolsGUI Designer ...

AccuTerm 2K 2 includes a development tool to help programmers
create GUI applications for MultiValue systems. If you are
connected to a MultiValue host, you can access theGUI Designer

by selecting this menu option or clicking the{ | button on the

toolbar.

Tools MultiValue Options...

Selecting this menu item displays theAccuTerm MultiValue TCL
Rules dialog box. Several of AccuTerm's MultiValuetools
(Upload Wizard, Download Wizard, wED Editor and GUI
Designer) require a special MultiValue server utility to function.
The server utility istypically initiated from “TCL”, and settingsin
this dialog define how AccuTerm gains accessto TCL.

Tools Macro Record New Macro

Select this menu item to begin recording a new macro. All menu
and toolbar actions, including changing settings and preferences,
are recorded in the macro. Also, keystrokes sent to the host and
responses from the host are recorded in the macro. When a macro
is being recorded, asmall control window is shown in the lower-
right corner of the screen. Use the control window to end, pause or
resume macro recording.

ToolsMacro Run Macro

This menu item opens a sub-menu which contains alist of recorded
macros. Select the macro you want to run from this sub-menu.
Note: a shortcut key can be assigned to a recorded macro to
simplify running the macro.

Tools Macro Edit Macros

This option opens the AccuTerm Script window with the Macro
tab (2) selected. Use this window to examine or modify the VBA
code for your recorded macros

Tools Script...

This option opens the AccuTerm Script window with the Main
script tab (1) selected. Use this window to create, modify, run and
debug VBA scripts.
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Reset Menu
This menu has options to reset the terminal or the connection.

Reset Terminal

Resets the terminal (clears screen, restores default character set and
emulation, etc.) You can quickly reset the terminal by clicking the

8| button on the toolbar.

Reset Connection

Resets the connection. If the session has been disconnected, this
command will attempt to reconnect. Y ou can quickly reset the

connection by clicking the[¥=: | button on the toolbar.

Window Menu

The Window menu contains options for re-arranging the open sessions
within the main window, and for switching from one session to another.

Window Cascade

This option arranges all open session windows so that they overlap.

The title bar of all session windows remains visible.
Window TileHorizontally and Window Tile Vertically
These options arrange all open session windows so that no
windows overlap.

Windows

The open sessions are shown at the end of the Window menu. Y ou
can switch to any session by clicking on its entry in this menu.

Help Menu

Y ou can get context sensitive help at any time by pulling down theHelp

menu and selecting thel ndex or Contents option or by clicking the

7]

button. To display information about AccuTerm, including version, release,
serial number and registered user, select the About AccuTerm option.
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Keyboard Commands

Next Session —CTRL + TAB

If you have multiple session windows open, pressCTRL + TAB to
activate the next session. The sessions are sequenced in the order
they were last active. Y ou can pressTAB multiple times while
continuing to hold the CTRL key to scan the session windows until
you find the one you want to activate.

Print Screen - ALT+G
Prints the terminal screenon the currently selected printer.

Data Capture- ALT+ C
Thisisa shortcut to open upthe Begin Capturedialog box.

Toggle Slave Printer Mode- ALT+ P
Toggle slave printer mode on and off.

Previous Page - CTRL + PGUP
Displays the previous terminal page. To use this command, the
session must be setup with more than one video page.

Next Page - CTRL + PGDN
Displays the next terminal page.

Pause / Resume- SCROLL LOCK

This command pauses or resumes the processing of received data
by the terminal. The keyboard “ Scroll Lock” LED indicates the
current status.

Scanning the History Buffer

Use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT
+ UP, CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL +
SHIFT + END to navigate the history buffer.

Besides using the keyboard to navigate the history buffer, yau can
also use the mouse wheel (if your mouse has awheel). Just scroll
the mouse wheel up or down to scroll the history.

Note: you must specify a number of history rows to enable history
scanning. To specify the number of history rows to utilize, choose
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Settings from the Tools menu, Click on the Screen tab. Enter the
desired number of rows.

18
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CONFIGURING ACCUTERM

Before you can use AccuTerm, you must configure the program. The
configuration processis used to tailor AccuTerm to your specific
environment: workstation, printers, network and host computer. Y ou can
also choose certain preferences. This chapter describes the configuration
process.

To modify AccuTerm’s settings choose the Settingsitem from the Tools
menu or click the button on the toolbar.

The Settings dialog box is organized into ten categories, with each category
on a separate index tab. Click on one of the index tabs to display the settings
for that category. Y ou can also press thenumber of the category while
holding the ALT key (use ALT + O for 10 — Misc).

When you have completed your changes, simply pressENTER (or click the
OK or Apply button) to save changes, or pressesc (or click the Cancel
button) to discard changes and close the Settings dialog box.
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General Settings

The General tab is used to specify settings that affect the AccuTerm
application overall, rather than a specific session.

Default phone book

Thisfield contains the file name to be used as the default phone bookfor the
diaer. If nodirectory is specified, the current directory is assumed. All
dial-up sessions share this phone book.

The phone book fileis atab delimited ASCII file, with one line per entry;
name and phone number are the two fields.

TCP/IP hostsfile

The TCP/IP hostsfileis an information file used to supply alist of host
names to choose from when configuring atdnet or ssh connection. It is not
necessary to define this entry, but if you know that your system has a hosts
file, you can specify it here.

Default upload/download directory

This field contains the default directory for uploading and downloading
files. Each session hasits own setting (File Transfer tab) for this directory
which will override thisfield if it is present.

Default capturedirectory

Thisfield contains the default directory for storing captured data. Each
session hasits own setting (File Transfer tab) for this directory which will
override thisfield if it is present.

Session title format

Each session window has a “title”, shown in the window’ s title bar. Thetitle
consists of the session file name (or optional title specified in theScreen
tab), and the session number (or ID). Y ou can customize how the title and
ID are displayed in the window title bar by choosing analternate title
format. Optionsinclude displaying the ID after (default) or before the title,
and enclosing the ID in parentheses () or brackets| ].
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Recent filesize size

Specify the number of filesto be shown at the end of the Eile menu for
quickly opening your most frequently used sessions. Normally, the last four
files are shown.

Singleinstance of AccuTerm

If this option is checked, only one instance of the AccuTerm program is
allowed to be running. If you try to start AccuTerm from the Start menu or
desktop shortcut, and an instance of AccuTerm is already running, the
currently running program will be activated. When this option is not
checked, a new instance of the AccuTerm program will be stared; that is
you will have two or more AccuTerm applications running.

Close AccuTerm when all sessions closed

If this option is checked, when the last open session is closed, the AccuTerm
program will automatically close. This option isuseful for network users
when opening a configuration or layout file from a shortcut so that when all
network sessions have been disconnected, AccuTerm will close
automatically, without user intervention.

War n befor e disconnecting

If this option is checked, when you attempt to close a session which is
currently connected to the host (modem, Telnet, SSH connections), you will
receive awarning that the session is still connected. Y ou can choose to
cancel the close operation if you wish. When this option is not checked, you
will not receive this warning and the connection will be closed immediately.
This warning does not apply to serial port connections.

Show large buttonsin toolbar
Check this option to use large buttons in the toolbar. If this option is not
checked, small buttons are used.

Remember Capsl ock and ScriL ock state when activating

When this option is checked, AccuTerm remembers and restores the state of
the CapsLock and ScrollLock keys when the program is activated. Each
session maintains its own independent state for these keys. This option is
only available for Windows NT, 2000 and XP.

Function key bar: at top of screen
Check this option to show the function key bar at the top of the session
window. If this option is not checked, the bar will be displayed at the bottom
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of thewindow. Note: you must check the Function bar itemin the View
menu to show the function key bar.

Function key bar: show key numbers
Check this option to show tiny key numbersin the corner of each button in
the function key bar.

22 Configuring AccuTerm



Connection Settings

Connection Method

The Connection Method is used to select what type of connection or
communications device you use between your computer and the host
system. You will always be able to select Serial Port as a connection type.
Depending on the hardware and software you have installed in your
computer, you may also be able to select M odem, Telnet, Secure Shell or
PicLan.

After selecting or changing the connection type, other settings relating to the
selected connection type are enabled. For example, if Serial Port is
selected, various options for a serial port connection, such as the port
number, baud rate, parity, etc. will be shown. The specific settings for each
connection type will be described later inthis section.

Duplex

There are three duplex options: Full, Half and L ocal. In Full duplex, all
characters typed on your keyboard are sent to the host computer. They are
not printed on the screen. The host usually sends (echoes) the same
character back; thisiswhat is displayed on the screen. Thisis by far the
most common configuration. InHalf duplex, the characters you type are
sent to the host machine and displayed on the screen. If the host system is
configured for Full duplex and you select Half duplex on your computer,
you will see each character that you type two times! InL ocal mode,
characters you type are displayed directly on the screen and are not sent to
the host computer.

Strip Eighth Bit

Most connection types use eight bits to represent each character. When
using eight bits, the computer can send up to 256 different character codes.
Some terminal types have no way of handling characters above 127 (hex
7F). In this case, you can check this box and the eighth bit of each byte will
be automatically stripped from all received characters. If you need to use
any international characters or special symbols from the PC character set,
you will need to clear this box to access them (the Wyse 60 and V Txxx
emulations have commands to access these characters when using only 7
bits).
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Close session on disconnect

This option is most useful when using Telnet or Secure Shell connections.
If this option is checked, then when the connection is terminated by the host
computer, the session will automatically close. This option may be used in
conjunction with the general setting “ Close AccuTerm when all sessions
closed” option.

Display communication errors

This option determines if communications errors are displayed or ignored.
When using a network connection (Telnet, Secure Shell, PicLan) it isbest to
enable this option. For Serial Port and Modem connections you may want to
disable this option, since “UART Overrun” errors are common and usually
do not indicate areal problem. If you suspect you are encountering errors,
for example, if columns do not line up on a formatted screen, try setting this
option, then reset the terminal (select theReset Connection option from the
main menu).
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Connection Settings — Serial Port

Port

Select the seria port on your computer which is connected to your host
system. If you select the wrong port, you may get an error such as
“Communication Port Unavailable’, or your terminal session may act like it
is not connected.

Note: although AccuTerm allows you to select from port number 1 to 127,
most computers only have one or two portsinstalled. To use any port with
AccuTerm, it must first be correctly installed with the correct device driver.

Baud Rate

The baud rate is the speed that the serial port communicates with the host
computer. AccuTerm supports baud rates from 300 to 115,000 baud. This
setting must match the setting of the host computer’s seria port to which
your computer is connected. Baud rates of 9600 or 19,200 are most
common.

Data Bits

Data Bits refers to the number of bits the serial port sends to represent each
character. The options are 7 or 8 bits (the default is 8 bits). This setting must
match your host system'’s serial port setting.

Stop Bits

Thisisthe number of bits that the serial port uses to separate each character.
The options are 1 or 2 stop bits (default is 1). This setting must match your
host system’s seria port setting.

Parity

Parity is an error checking mechanism performed by the serial port. The
options are: None, Odd, Even, Mark and Space. Parity israrely used, so
selecting None (this is the default) is usualy correct. This setting must
match your host system’s serial port setting.

Handshake

Computers can send information very quickly. However, there are situations
where one computer can send data faster than the other computer can
process it. In these cases, the computer on the receiving end needs to inform
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the sending computer to suspend transmission until the slower computer is
ableto catch up. A technique called “handshaking” is used to accomplish
this task.

AccuTerm supports three methods of handshaking. The first and most
common is. Xon/Xoff (or software handshake). With this method,
AccuTerm sends a specia Xoff character (DC3) to the host system when it
wants the host to stop sending characters. When the AccuTerm has caught
up, it sends the Xon character (DC1). AccuTerm normally uses “inbound”
Xon/Xoff handshake; that is, AccuTerm can control flow of data fran the
host, but the host cannot control the flow of data from AccuTerm. If you
check the “bidirectional” option, then AccuTerm will use both “inbound”
and “outbound” Xon/Xoff handshake allowing the host to control the flow
of datafrom AccuTerm aswell.

The second handshake method supported by AccuTerm isDTR/DSR This
method is referred to as hardware handshake because it physically changes
the voltages on the serial port to indicate whether the receiving computer is
ready.

The third handshake method, RTS/CTS is similar to DTR/DSR handshake,
except it uses adifferent pair of signals (pins) on the seria port.

For DTR/DSR or RTS/CTS handshake to work, the cable which connects
your computer and the host computer must conrect the appropriate
handshake signals at both ends. Physical cable wiring is beyond the scope of
this manual.

This setting must match your host system’s serial port setting.
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Connection Settings - M odem

AccuTerm 2K 2 supports dial-up connections using any modem you have
installed on your computer. AccuTerm uses TAPI (a service built into
Windows for supporting tel ephony) to communicate with your modem. By
using TAPI, AccuTerm can share the modem with other TAPI enabled
applications, like Windows fax applications.

Modem Name
To use amodem connection, select a modem from the Modem Name list.

Note: if you change the modem installed in your computer (or sometime just
install an updated driver for your modem), the modem name savedin your
terminal session configuration file may not match the new modem name. If
this happens, open the Settings dialog and select the new modem name from
the Modem Name list.

Auto Answer
If you want AccuTerm to answer incoming calls, enable this setting’,
otherwise disable (default) this setting.

Override Port Settings

Normally, AccuTerm configures the modem based on settings that are set up
in Control Panel (Phone and Modem Options). Selecting this option allows
you to override those settings. When this option is checked, options for
selecting the modem baud rate, data bits, stop bits, parity and handshake
become available.

See the previous section (Connection Settings- Serial Port) for details
about baud rate, data bits, stop bits parity and handshake settings.

Note: most modern modems work best using RTSCTS handshake.

Dialing Options

To modify the dialing properties for the selected modem, such as your
current location, area code, dialing prefixes, etc., click the “Dialing
Options’ button.
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Connect Only at This Speed

If the “Override port settings’ option is selected, the “ Connect only at this
speed” option will be available. Normally, the baud rate of the modem’s
seria port is set to the speed selectedin the baud rate setting. However, the
baud rate used to communicate between your modem and the host
computer’s modem is negotiated by the two modems, and may not be the
same as the baud rate setting. By selecting the “ Connect only at this speed”
option, AccuTerm will attempt to lock the modemto-modem baud rate at
the same speed as the baud rate setting.

Thisoption is useful if you are able to dial and connect to the host computer
modem, but the characters you receive are unintelligible garbage. This
usually indicates a mismatch in the baud rate, usually between the host
computer and its modem.

Note: this option does not work with all modems.
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Connection Settings - Telnet

AccuTerm supports Telnet connections to host systems on a TCP/IP
network. Any Telnet server (host) on the network, including hosts on the
Internet, can be accessed.

Host Name

A valid Telnet host nameor |P address must be entered in thisfield. If a
HOSTSfileisavailable, you can click on the downarrow to display alist of
available Telnet hosts.

Host Type

If your type of host you are connecting to is listed in the Host Type list,
please select it, otherwise just use the default hest type. By selecting a host
type from thislist, certain advanced options are set up to be compatible with
the specified host type. To see the advanced options, click on the Advanced
button.

Port

If the Port field is left blank, or set to “ default”, AccuTerm will use TCP
port 23 (the default for Telnet). If adifferent port isused for Telnet on your
desired host machine, enter that port number in this field.

Certain host systems, such as Raining Data D3, allow a host process number
(PIB) to be mapped to a specific TCP port number. Y ou can use the Port
setting to specify the port number mapped to your process number. Consult
with your system administrator for this setting.

Connect Timeout

When establishing a connection to a host computer, AccuTerm will wait for
a specified time for a response from the selected host system. Y ou can
specify the number of seconds AccuTerm should wait. If thisfield isleft
blank, or zero, the default timeout is 15 seconds. Note: this timeout only
affects the time AccuTerm waits for a response from the host when opening
a connection to the host.

Advanced Options

By clicking on the Advanced... button, you can modify various Telnet
options. These options are generally set by selecting a Host Type, but may
be modified if necessary.
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If you change any settings in the advanced Telnet options, the host type you
have previously selected will be changed to “custom”.

Echo (advanced option)

Most systems require the host to echo characters received back from the
client (terminal). That is, when you press akey, a character is sent to the
host, and the host sends that same character back to the terminal, at which
timeit is displayed on the screen. If this behavior is desired, then select the
echo option (default). If the echo option is not selected, then theDuplex
setting should be changed to “half” to enable local echo of typed characters.

Binary (advanced option)

Normally, Telnet operatesin Text mode, with special rules for handlingcr
and LF characters. When the Binary option is selected, Telnet sendscr and
LF characters without any alteration. Some hosts do not function correctly in
Binary mode.

Use alternate break signal (advanced option)

Normally, Telnet sends theInterrupt Process command when you press
CTRL + BREAK key. When this option is selected, Telnet sends the Telnet
Break command instead.

Bypass option negotiation (advanced option)

When this option is selected, Telnet option negotiation, which normally
occurs When establishing a connection, is skipped. Certain Telnet servers,
like Raining Data D3, do not support Telnet option negotiation, and require
this option.

Send keepalives (advanced option)

When this option is selected, AccuTerm will send a dummy “keepalive”
message to the host periodically (about every 2 minutes). This dummy
message is discarded by the host and is transparent to the terminal session.
This feature may be useful when the host system (or network equipment
such as arouter) disconnects an idle connection.

Note: certain Telent servers, like Raining Data D3 running on Window NT
or 2000, are not compatible with this option.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the
expense of increased network traffic.
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Use U2 device licensing (advanced option)

By selecting this option, multiple connections (sessions) to Enterprise
versions of UniData and UniV erse consume only a single user license.
When the Suppress L F option is checked, the response sent to the host by
AccuTermis not terminated by anLF (line feed) character. Contact your
IBM U2 dealer for information regarding device licensing.
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Connection Settings — Secur e Shell (ssh)

AccuTerm supports secure connections to host systems over a TCP/IP
network using Secure Shell (ssh). Any ssh server on the network, including
hosts on the Internet, can be accessed. AccuTerm implements both version 1
and version 2 of the Secure Shell protocol. Protocol selection is usualy
automatic and uses version 2 if it is supported by the host. Otherwise, it
automatically falls back to version 1.

Secure Shell employs public key encryption technology to ensure that your
connection to the host is secure, even over the Internet. When you set up a
Secure Shell connection, all information, including your user ID, password
and session data is encrypted before transmission over the network.

AccuTerm Secure Shell requires Windows 128 bit encrypion. To verify that
you have the 128 bit encryption installed, open Internet Explorer, and select
About Internet Explorer from the Help menu. If Cipher Strength is 128
bit, then you should be able to create a Secure Shell connection. If it is not,
you may need to upgrade you version of Internet Explorer to version 6 or
higher, or install the High Encryption Pack (search for “High Encryption” at
Www.microsoft.com).

Host Name

A valid SSH host nameor IP address must be entered in thisfield. If a
HOSTSfileisavailable, you can click on the downarrow to display alist of
available hosts.

Port

If the Port field is left blank, or set to “default”, AccuTerm will use TCP
port 22 (the default for ssh). If adifferent port is used for ssh on your
desired host machine, enter that port number in this field.

Connect Timeout

When establishing a connection to a host computer, AccuTerm will wait for
a specified time for aresponse from the selected host system. Y ou can
specify the number of seconds AccuTerm should wait. If thisfield isleft
blank, or zero, the default timeout is 15 seconds. Note: this timeout only
affects the time AccuTerm waits for aresponse from the host when opening
a connection to the host.
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SSH Version

Select the version of the SSH protocol that will be used by the connection.
When you select “auto”, AccuTerm will automatically select the highest
version supported by the host. If you select SSH1 or SSH2, AccuTerm will
only connect using the selected protocol. If the host does not support the
selected protocol, the connection will fail and an error message will be

displayed.

Authentication
Select the authentication method which will be use to validate the user with
the host. AccuTerm supports both password and public key authentication.

Key

If public key authentication has been selected, click the Select... button to
open the Key Management dialog. Use the Key M anagement dialog to
create new keys, load existing keys and import keys created on another
system.

Advanced Options
By clicking on the Advanced... button, you can modify various Secure
Shell options.

Break character (advanced option)

Specify the character used to indicate a Break in thisfield. The default is 3
(cTRL + C) but you can enter any ASCII codein thisfidd if your host
requires a different break character.

Preferred Cipher (advanced option)

If you wish to select the cipher used to encrypt the SSH session, you can
select it from thislist. If “auto” is selected, thedefault cipher (triple DES) is
used. Otherwise, you can choose triple DES Blowfish, 128 bit AES or 256
bit AES. Note: the AES cipher is only available when using the SSH2
protocol, and requires Windows XP.

Must Use Preferred Cipher (advanced option)

When this option is set, the cipher selected above must be supported by the
host. If the selected preferred cipher is not supported by the host, the
connection will be terminated and an error message displayed. When this
option is not set, if the preferred cipher is not supported by the host, a
different, mutually supported, cipher (normally, triple DES) will be used.
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Send keepalives (advanced option)

When this option is selected, AccuTerm will send a dummy “keepalive”
message to the host periodically (about every 2 minutes). This dummy
message is usually discarded by the host and is transparent to the terminal
session. This feature may be useful when the host system (or network
equipment such as routers) disconnects an idle connection.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the
expense of increased network traffic.

U2 device licensing (advanced option)

By selecting this option, multiple connections (sessions) to Enterprise
versions of UniData and UniV erse consume only a single user license.
When the Suppress L F option is checked, the response sent to the host by
AccuTermis not terminated by anLF (line feed) character. Contact your
IBM U2 dealer for information regarding device licensing. Note: at this
time, AccuTerm does not support U2 device licensing for Windows versions
of U2.
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Connection Settings — SSH K ey M anagement

When configuring a Secure Shell connection, AccuTerm supports both
password and public key authentication. When public key authentication is
selected, click the Select... button to open the Key M anagement dialog.

Use the Key Management dialog to create public/private keys for SSH, or to
load or import private keys. AccuTerm supports RSA public keys for both
SSH 1 and 2, and DSA public keysfor SSH 2. AccuTerm can import SSH 2
private keys that were created by OpenSSH. The public key file format
AccuTerm usesis also compatible with OpenSSH (www.openssh.org).

Creating a new key

Click the Create New K ey button to create a new public/private key pair.
After clicking the Create New K ey button, select the key type (RSA or
DSA), and key length. The default length of 1024 bits is recommended.
Enter a descriptive comment describing the key being created, andenter a
passphrase to protect your private key. Although the passphraseis optional,
it is highly recommended since anyone that gains access to your private key
file can impersonate your identity! Once the passphrase is confirmed, the
icon to the right of the passphrase field changes from ared X to agreen
check-mark.

Click the Generate New K ey button to generate the new key pair. This
process may take some time to complete. When key generation is finished,
the “fingerprint” for the public key will be displayed.

Click the Save K ey File button to save the newly created key file. By
default, AccuTerm will save the key in its standard key folder. Y ou can
select adifferent location, such as aremovable USB drive, if desired.

Once your key pair is created, you need to place the public key on the server
which you want to connect to. Y ou can save the puclic key to afile by
clicking the Copy Public K ey button with theto file option selected. Once
saved, you could attach the key to an email message and send it to the
server’ s administrator (it isa public key, so security is not amajor issue).

Y ou could also save the public key file to aremovable drive or diskette and
mail or take it to the server administrator.
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If the server uses OpenSSH (or compatible) files, and if you currently have
access to the server viapassword authentication, you can set up public key
authentication using the following steps:

1) Open an AccuTerm session and connect to the server. Log in using
your password.

2) Openthe AccuTerm Settings dialog to create your new key pdr.
Click the Connection tab. Change the setting for Authentication
from password to public key.

3) Click the Select... button to open the Key M anagement dial og.

4) Click the Create New Key button and follow the steps above for
creating a new key.

5) Select theto clipboard option and click the Copy Public Key
button to copy the public key to the clipboard.

6) Click OK two timesto dismiss the dialogs. Ignore the warning
about changes not being effective.

7) FromaUnix/Linux prompt, change to your ~/.ssh directory. Edit
the authorized keys2 file using your favorite text editor. Start a
new linein the authorized keys2 file.

8) From the AccuTerm Edit menu, choose Paste to paste the public
key into the authorized_keys2 file.

9) Savethe modified authorized key< file.

10) Savethe modified AccuTerm session file. Close AccuTerm. Open
AccuTerm and choose the session file you just modified.

11) Enter your user ID.

12) If you entered a passphrase when you created your new key, you
will prompted to enter the password Enter the passphrase (case
sensitive).

13) If the server accepts your key, you will be logged in.

L oading an existing key

If your private key was saved to a different folder or to aremovable drive or
diskette, you can click theL oad Existing K ey button to load that key. Enter
the passphrase and click the Verify button to check the passphrase. If the
passphrase is correct, the public key fingerprint will be displayed. ClickOK
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to use this key (in its current location). Otherwise, you can save the key ina
different location by clicking the Save K ey File button.

Importing a key

Importing akey is exactly like loading an existing key, except for the file
locations. AccuTerm can import private keys created using the OpenSSH
file format.

Key fingerprint

When you create a new key, or load or import an existing key, AccuTerm
displaysthe “fingerprint” of the public key. Y ou can use this fingerprintto
ensure that your key is correct. Use a utility on the server to srow the
fingerprint of the public key and compare to the fingerprint shown in
AccuTerm.
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Connection Settings — PicL an

AccuTerm supports Modular Software's PicL an network for Pick hosts.
Any PicLan enabled host (server) on the network canbe accessed.

In order to use a PicLan connection, the PicLan client software must first be
installed. Since PicLan utilizes the IPX network protocol, you must also
install the IPX protocol in your network configuration.

AccuTerm supports up to ten PicLan connections allowing up to ten
concurrent PicLan sessions.

Host Name

A PicLan host (server) name must be entered in thisfield. Click on the
down-arrow to display alist of available PicLan hosts (AccuTerm queries
the network to assemble thislist, it may take several seconds for thisto
occur).

Port

Enter the port (host process, PIB or port number) to be used to connect to
the PicLan host. Thisfield may be left blank or may be set to “ default” to
indicate that any available port may be used.

Connect Timeout

When establishing a connection to a host computer, AccuTerm will wait for
a specified time for a response from the selected host system. Y ou can
specify the number of seconds AccuTerm should wait. If hisfield isleft
blank, or zero, the default timeout is 15 seconds.
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Terminal Type Settings

AccuTerm emulates avariety of terminals. In order to use AccuTerm with
your host applications, you must select the correctterminal type for
AccuTerm to emulate. The correct terminal type depends on the terminal
type your host and/or application software requires. If you are unsure, you
might type “TERM” at aMultiValue (D3, U2, jBase, etc.) command (TCL)
prompt, or type “echo $TERM” at a Unix/Linux command prompt. The
response may help you “guess’ the correct terminal type. If the application
screens look correct, then you probably have the correct type; otherwise, try
another terminal type.

Terminal Emulation

Wyse 50: emulates a Wyse 50 terminal with “Enhanced” enabled.
Wyse 50 emulation may also be used for Wyse 30, 99, 125 and 350
terminals.

Wyse 60: emulates a Wyse 60 terminal with “Enhanced” enabled.
Wyse 60 emulation is similar to Wyse 50, but with non-embedded
visual attributes (the visual attribute codes do not take a position on the
screen). Wyse 60 emulation may also be used for Wyse 150, 160 and
320 terminals.

ADDS Viewpoint A2: emulatesan ADDS Viewpoint A2 terminal.
Thisisthe origind A2 terminal, with no enhancements.

ADDS Viewpoint 60: emulates an ADDS Viewpoint 60 terminal. The
Viewpoint 60 is similar to the A2, but uses embedded visual attributes
(the visual attribute codes take a position on the screen).

Procomm VP60: emulates an ADDS Viewpoint 60 terminal, but with
non-embedded visual attributes. This emulation is similar to the
Viewpoint 60 emulation provided by Procomm.

Viewpoint A2 Enhanced: emulates a Wyse 50 terminal in ADDS
Viewpoint mode with “Enhanced” enabled. Thisis basically a hybrid of
Wyse 50 and ADDS Viewpoint A2. Viewpoint A2 Enhanced may also
be used for ADDS 2020 and 4000, and NCR 2900 terminals.
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MDIS P30 (Prism): emulates a McDonnell Douglas Prism P30
terminal.

VT52: emulates the DEC VT52 terminal.

VT100: emulates the DEC VT100 terminal. VT100 is a 7-bit
emulation, and can also be used for applications which require VT102
terminals.

VT220: emulates the DEC VT220 terminal. The VT220 emulation
provides a super-set of the VT100 commands, and includes support for
a host-writable status line, protected characters, multiple character sets
and multiple pages.

VT320: emulates the DEC VT320 terminal. The VT320 emulation
provides a super-set of the VT220 commands, and includes support for
reporting and restoring various termina states.

VT420: emulates the DEC VT420 terminal. The VT420 emulation
provides a super-set of the VT320 commands, and includes support for
rectangle operations, left & right margins, and horizontal split screen.

ANSI BBS: emulates the old MS-DOS ANSI.SY S device driver. This
emulation may be useful when connecting to older bulletin board
systems.

Linux Console: emulates the Linux console, including function keys
and colors.

SCO Console: emulates the SCO Unix console.

Pick PC Monitor: emulatesthe origind Pick PC Monitor (“mmmon”
or “1” terminal type), including color and function keys.

Tektronix 4014: emulates the Tektronix 4010/4014 terminals. Color
enhancements as implemented in the CIT467 terminal (from CIE
Electronics) are included.

Tektronix 4100: partially emulates the Tektronix 41xx terminals.

TTY Emulation: emulatesbasic TTY functions.
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Status Lines

Some of the terminals that AccuTerm can emulate display status, function
key labels or host messages on the top or bottom lines of the screen. If you
select aterminal emulation that supports status lines, the supported status
line options will be enabled for you to select.

For Wyse and ADDS emulations, up to 3 status lines are available: a host
message line at the top of the screen, and a “ shifted” label line and
“unshifted” label line at the bottom of the screen. For VT emulations, only a
single status line is available for displaying a message from the host at the
bottom of the screen. For the console emulations, the status ine is not
supported.

No message or statusline
Select No message or statuslineif you do not want any status or

message lines.

Shared message & statusline

Select this option to use a single, shared line at the bottom of the
screen. If the native terminal supports more than one line (Wyse
and ADDS Viewpoint), the bottom row of the screen displays the
most recently used line. The line is shared between label line,
shifted label line and host message line.

Split message & statuslines

Select this option if you want two separate status lines. The host
message line is the top row of the screen display, and the label line
is displayed on the bottom row. If the shifted label lineis
programmed, pressing the SHIFT key displays the shifted label line.
Releasing the SHIFT key displays the unshifted label line.

Host Terminal Type

Many hosts alow the client (terminal) to specify aterminal type when a
connection is established. AccuTerm uses the default terminal types of tty,
viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220, vt320, vt420, vt52,
ansi, linux and pickmon, depending upon the selected terminal emulation.
If adifferent terminal typeisrequired, you canenter it in thisfield.

Use multinational character set

For some emulations, you can select the multinational character set by
checking this option. If the option does not apply to the selected emulation it
will not be shown.
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ANSI Options
When any ANSI terminal type (V Txxx, Linux Console or SCO Console) is
selected, several additional options may also be selected.

Send 8 bit controls

When this option is selected, AccuTerm will send control
characters from the CO and C1 sets. If the option is not set, C1
controls are sent using an equivalent 7-bit escape sequence.

Allow application mode

When this option is selected (default), commands that switch the
numeric keypad keys and cursor keys into “applicaion mode” are
recoghized. When the option is not selected, those commands are
ignored, preventing the terminal from switching to “application
mode”. This option is useful when the host or application
erroneously sends the command to enter application mode

Keypad sends application codes

When this option is selected, the humeric keypad sends application
codes (similar to function keys). When not selected, the numeric
keypad sends numbers.

Cursor keys send application codes
When this option is selected, the cursor (arrow) keys send special
application codes instead of cursor movement codes.

Backspace key sends DEL
When this option is selected, theBKSP key sends the DEL control
code. When not selected, theBKSP key sends the BS control code.

Auto-print worksjust like VT terminal

When this option is selected, the “auto print” slave printer function
worksthe sameasarea VT terminal. That is, when AccuTerm is
in “auto print” mode, the entire screen line that the cursor ison is
printed when AccuTerm receivesacRr, LF or FF control code. If
this option is not checked, then text is printed as it is received from
the host (similar to Wyse auto-print mode).
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Screen Settings

The Screen tab lets you set terminal screen options like the screen size,
cursor type, and history rows. Y ou can aso change the session title or icon.

Session Title

Thisisthe text that will be displayed on the session window title bar. If the
titleis blank, the name of the current session configuration file is displayed.
When the session is maximized, the session title becomes part of the
AccuTerm main window title.

Session lcon

Each session window has an icon displayed in the window title bar (or menu
bar if the window is maximized). Click theChange... button to select a
different icon.

Screen Sizes

There are two separate screen sizes that AccuTerm supports: normal and
extended. These sizes are used to emulate the 80 and 132 columnmodes of
the Wyse and VT terminals. AccuTerm has taken the extended and normal
modes one step further. With AccuTerm you can define both the normal and
extended modes to be any number of colurms or rows up to a maximum of
240 columns by 240 rows.

You will probably leave these settings at their default settings of 80 columns
by 24 rows for normal modeand 132 columns by 24 rows in extended

mode. If you have software that supports other screen sizes, you can
experiment with these settings until you find a size that you like.

The number of rows may change if you change terminal emulations. The
console terminal emulations use 25 rows with no status line; others use 24
rows with one or more status lines.

When AccuTerm switches between the normal and extended modes, one of
two things will happen: either the characters will change size to fit the
visible screen, or scroll barswill be displayed if the full screen will not fit
within the current window at the selected character size. For more
information on scaleable fonts, see the section onFonts.
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Video Pages

Many of the terminals AccuTerm emulates support multiple addressable
pages. With AccuTerm, you can have up to 25 pages. Eat page requires
memory, so if you don’'t use them, it is better to leave this number set to the
default value of 1.

History Rows

AccuTerm supports a“ history buffer”, which saves lines which hare
scrolled off of the terminal screen. To use this feature specify how many
rows (up to 10,000) are to be saved. When the history buffer has been
enabled (by setting the number of rows), use the vertical scroll bar, mouse
wheel, or keyboard commands to scan history.

You can use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT
+ UP, CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL + SHIFT +
END to scan the history buffer.

History Scroll Bar
When a history buffer has been enabled, the vertical scroll bar may used to
scan through the history. AccuTerm supports three scrolk-bar settings.

Auto: when “Auto” (the default mode) is selected, placing the mouse
near the right edge of the screen will cause the scroll bar to “dlide” into
place. Moving the mouse away from this area causes the scroll bar to

disappear.
On: when “On” is selected, the scroll bar will always be present.

Off: when “Off” is selected the scroll bar will only be present if the
window height isnot large enough to display the current screen height.

Note: when Auto or Off are selected, using the keyboard commands or
mouse wheel to scan history causes the scroll bar to be displayed briefly.
Thisis so that you can see the position of the scroll button after scrolling
the window.

Enable Tektronix Graphics

Checking this box enables the Tektronix 4010/4014/4100 graphic terminal
emulation. If the graphics mode is enabled, AccuTerm will automatically
switch to the Tektronix graphic emulation when it receives the appropriate
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command from the host computer. AccuTerm will return to the previous
emulation mode when graphics mode is terminated.

There may be times when you want to disable the graphic emulation. If you
have a bad modem connection and are getting random garbage characters on
the screen, AccuTerm may accidentally switch into graphics mode.
Sometimes a software program may send the graphics mode control
seguence at the wrong time. If this happens, disable the graptics mode until
you need it.

Enable Mouse

This option determines whether host mouse support is enabled. Under
normal operation, if you click on the terminal screen with the mouse,
nothing happens. If a“mouse on” command is receivedfrom the host while
this option is checked, AccuTerm sends a specia code informing the host of
the mouse location when the button was pressed, and which mouse button
was pressed. The mouse cursor is aso changed to a“pointing hand” to
indicate that the mouse is active.

Block Cursor
Checking this option turns the cursor into a blinking block instead of an
underline.

Extended Mode

Checking this option sets the screen to extended (132 column) mode. This
can be used to manually switch between extended and normal (80 column)
modes.

Disable Line Wrap

When this option is checked, automatic linewrap is disabled. When the
cursor reaches the end of aline, typing another character nommally causes
the cursor to move to the beginning of the next line. When this option is set,
the cursor does not move.

Disable Blinking
Checking this option disables the “blinking” visual attribute. Characters
tagged with the blink attribute will not blink.

Disable Underline
Checking this option disables the “underling” visual attribute. Characters
tagged with the underline attribute will not be underlined.
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Answer back

The contents of the Answerback field are sent to the host when AccuTerm
receives arequest to transmit the answerback string under Wyseand VT
emulations. When the answerback message is sent to the host under Wyse
emulation, an AcK control character follows the message. Under VT
emulation, no terminator is sent.

Control characters may be entered into the answerback field by prefixing the
character with acaret (A).
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Font Settings

AccuTerm displays text received from the host computer using a fixedpitch
font (all characters are the same size). Using a fixed-pitch font is necessary
because applications written to display on real terminals expect each
character to be the same size in order to align columns of data on the screen.

AccuTerm supplies a custom font which is used by default. Y ou are free to
choose another fixed-pitch font if you desire, however, AccuTerm'’s font has
been designed to scale nicely to different screen sizes.

Font

Thefont list shows all of the available fixed-pitch fontsinstalled on your
computer. The first font listed isthe AccuTerm font. This font has been
optimized to look good over awide range of character sizes and screen
resolutions. We recommend that you use this font, especialy if you have a
low resolution screen (640 x 480).

To choose a different font, simply click on the font you want to use.

Font Size
This box lists all font sizes available for the selected font. TheFont Sizelist
isdisabled if the Scale Font to Fit option is checked.

Scale Font to Fit

When this option is checked, AccuTerm automatically resizes the selected
font so that the entire terminal screen isvisible at the current window size.
This alows you to re-size the session window or change between normal
and extended video mode without having to deal with scroll bars to see
everything. However, if for some reason, you need lock the characters at a
specific size, you can un-check this setting and then pick the size you want
from the Font Sizelist.

Use Bold Font Style
If this option is checked, AccuTerm uses theBold font style if it's available
in the selected font.
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Keep Font Legible

If this option is checked, and the Scale Font to Fit option is checked,
AccuTerm will never scale afont smaller than 6 pixels wide by 9 pixels
high.

Host uses Windows char acter set

Use this option to change the default character set used by the selected
terminal type to the 8-bit (non-Unicode) character set used by Windows.
Y ou will need to select afont that supports al the charactersin the
Windows character set if this option is checked; the AccuTerm font only
supports the OEM (code page 437) and Western ANSI (code page 1252)
character sets.

Euro character
If your host application needs to display the Euro currency symbol, enter the
ASCII value of the Euro symbol, as used on your system.

Note: thereis no standard value for this symbol. Some possible vdues are
128 (Windows ANSl), 164 (Latin-1 currency and Latin-9 Euro) and 213
(IBM modified code page 850).
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Color Settings

Windows is capable of displaying text in awide variety of colors. The
colors are separated into character color and the background color. Most of
the terminal's being emulated do not support color. Instead, they have visual
attributes like normal, reverse, dim, blink, underline, etc. AccuTerm allows
you to map the various terminal visua attributes into a combination of
character and background colors.

AccuTerm uses a palette of 16 colors. Since most systems are capable of
displaying more than 16 colors, AccuTerm allows you to customize its
palette by selecting aColor Schemeor Visual Style, or by clicking the
Customize Palette... button. The palette also includes 6 colors used to
draw borders when using Visua Styles.

The mapping of visua attributes to colorsis displayed as a table with an
entry for each possible etribute. The Color column shows sample text
displayed in the selected character and background color along with a button
to change the colors. TheBorder column shows the selected border style
for the attribute. Click the Change button to select different character or
background colors. If borders are enabled (seeBorder Style below), choose
the border effect for the attribute from the drop-down list.
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Color Schemes

Default Colors: resets the palette to the 16 basic Windows colors, and
resets the attribute color mapping. Thisis often a useful starting point
when defining your own color mapping.

System Colors: sets several colors in the palette to “ system colors’
defined in the Windows Display Properties. The following standard
colors are replaced by a system color:

Black = Window Text Color

White = Window Background Color
Dark Blue = Highlight Background Color
Brown = Highlight Text Color

Light Gray = 3D Light

Dark Gray = 3D Shadow

Other palette colors are set the same as the default colors. Attribute
color mapping is set so that Normal, Dim, Reverse and Underline use
system colors from the modified palette.

Monochrome Colors: resets the palette to the 16 basic Windows
colors, then sets the atttribute color mapping so that characterand
background colors are black, white or gray. Select either dark or light
background for the Normal attribute. This setting often works well with
Unix and Linux utilities where a combination of visual attributes and
direct colors are used.
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Visual Styles

Visual Stylescan be use used to modernize character-based applications by
displaying screen elementsin a style that resembles typical Windows
screens. When you select aVisual Style, AccuTerm resets the palette to the
system colors as described above. Next, typical Windows colors are
assigned to the visua attribute mappings. Then theBorder Style setting is
changed to Thin and a border effect is assigned to specific attributes.

When using Visual Styles, use the following attributes to display screen
elements:

Screen background: normal

Field labels, headings, etc: normal
Disabled labels: dim

Active entry field: reverse

Inactive entry field: dim reverse
Highlighted field: reverse underline
Disabled field: dim reverse underline
Command button: underline

Inactive button: dim underline

Classic Windows: sets the palette to the system colors, and sets the
attribute color mapping as described above. Uses theinset border style
for text fields.

Windows XP: sets the palette to the system colors, and sets the
attribute color mapping as described above. Uses theflat border style
for text fields.

If your application uses different attributes for screen elements, feel freeto
modify the colors and border effectsto work with the attributes used by the
application.
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Protected Attribute

The Wyse 50 and Wyse 60 emulations require a visual attribute to be
assigned as the “ Protected” attribute. To select theProtected Attribute
click on the drop-down arrow, then select which visual attribute should be
used as the default protected attribute.

Border Style

If you are using Visual Styles (or the AccuTerm private programming
command to draw borders), you must select a border style. Choosethin for a
one-pixel border, or thick for atwo-pixel border. When external borders are
selected, vertical border lines are drawn in adjacent character cells.
Otherwise they are drawn inside the character cell andsometimes overlap
the left or right edge of the character; thin borders work best with smaller
font sizes, but are less dramatic than thick borders.

Line Drawing

AccuTerm supports the line and box drawing characters used by the native
terminals. AccuTerm supports three line drawing styles: normal, flat and
beveled. Choose normal to draw lines using the current character color.
Chooseflat to draw lines using the outer flat border color. Choose beveled
to draw 3D lines using theouter highlight and outer shadow colors.
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K eyboard Settings

AccuTerm supports a programmable keyboard. All of the function keys and
most of the keypad editing keys can be programmed.

Each terminal type has default programming for all of the keys which are
native to that terminal. Y ou do not need to program the default key codes.
The default codes are displayed in gray text.

If you wish to override the default programming, or to program keys that are
not native to the currently sdected terminal type, you can enter you own
codes here. Any key can be programmed with a character sequence (which
is transmitted to the host when the key is pressed), or a script command,
which is executed when the key is pressed.

The programmable keys are divided into eight categories: Nor mal, Shifted,
Control, Shift+Control, Alt, Shift+Alt, Keypad and Shifted Keypad. The
Normal key sequence is sent when one of the function keysis pressed by
itself. The Control sequence is sent when afunction key is pressed while
holding down the CTRL key. The Alt sequenceissent if theALT key isheld
down while pressing a function key. TheK eypad sequence is sent when one
of the editing keysis pressed. The Shifted, Shift+Control, Shift+Alt, and
Shifted Keypad sequences are sent when the SHIFT key isheld down in
combination with any of the previous keys.

The Keypad and Shifted Keypad tabs are used for programming the
special editing keys: BKSP, TAB, INS, DEL, HOME, END, PGUP, PGDN,
LEFT, RIGHT, UP, and DOWN.

To reset the selected group of keysto their default values, click theReset all
to default button.
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Key Code

To manually program function and keypad keys, first select theKey Type
from the tabs at the top of the panel. Next, enter the desired sequence into
the Key Codefield. next to the key name. To enter control characters, hold
the CTRL key and press the letter corresponding to the control character you
want to program. For CR (enter), DEL (delete) and TAB control codes, hold
the CTRL key and press theENTER, DELETE or TAB key. For theEscC
control code, pressCTRL + [, and for the BS (backspace) control code,
pressCTRL + H.

The carat (") and backslash (\) characters are used as special prefixesin
keyboard programming. If you need to enter either of these characters, just
enter two of them (™ or \\). This applies to both codes to transmit to the
host and script commands.

Alternatively, use the following table to enter control codes using spedal
prefix characters:

Key Control | AccuTerm Key Control | AccuTerm

seguence code notation seguence code notation
CTRL+@ | NUL A@ CTRL+ P | DLE AP
CTRL+A | SOH AA CTRL+Q | DC1 AQ
CTRL+B [ STX AB CTRL +R | DC2 AR
CTRL +C ETX ~C CTRL +S DC3 NS
CTRL+D | EOT AD CTRL+T | DC4 AT
CTRL+E | ENQ AE CTRL+U | NAK AU
CTRL+ F | ACK AF CTRL+V | SYN AV
CTRL+ G | BEL AG CTRL+W | ETB AW
CTRL+H | BS AH CTRL + X | CAN AX
CTRL+I |HT AT CTRL+Y |EM AY
CTRL+3J |LF AJ CTRL+Z | SUB AZ
CTRL+K | VT AK CTRL+ [ | ESC AL
CTRL+L | FF AL CTRL+\ |FS A\
CTRL+M | CR AM CTRL+] | GS A]
CTRL+N | SO AN CTRL+A | RS A~
CTRL+0 | S A0 CTRL+_ | US A_
A AR \ W
DELETE DEL A?
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To program a key with a script command, enclose any valid VBA statement
in square brackets ([ ]). See the Scripting section of the Programmers
Guide for more information on scripts.

Key Caption and Tip

When the Function Bar is displayed, you can enter a caption for each
function key. The caption will override the default button cagtion in the bar
for that key. Enter the caption in the Caption | Tip field. Strive to keep the
caption text short, as the key buttons are quite small. Y ou can also enter an
optional help tip in this field. Separate the caption and tip using a vertical
bar (). When the mouse hovers over the key button in theFunction Bar,
the tip will be displayed briefly.

You can enter atip even if you do not enter a caption or display the
Function Bar. Just begin the Caption | Tip field with avertical bar and
enter thetip. Thisis useful for documenting the purpose of the key
programming

Locking Programmed Keys

Most terminal types provide commands for the host to program the function
keys. If you would like the host to be able to reset and reprogram the keys,
select the Unlocked — host can reset or reprogram key option. If you
would like the host to be able reprogram keys, but not reset them to their
default values, select the L ocked — host cannot reset keysto defaults
option. If you would like to prevent the host fran resetting or
reprogramming key, select theL ocked — host cannot reset or reprogram
keys option.

Mapping F11 through F16

Some terminals (like Wyse 50 and 60) have more than 12 function keys on
their native keyboard. Since the PC keyboard only has 12 fundion keys,
AccuTerm allows you to map the nativeF11 through F16 keysto PC
keyboard CTRL + F1 through CTRL + F6 (and native SHIFT + F11 to SHIFT +
F16 to PC CTRL + SHIFT + F1 through CTRL + SHIFT + F6).

Start with CapsL ock On

Sometimes gpplications are designed for upper-case text. If you would like
the CapsLock key state to be "on" when the session is opened, check this
option.
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Copy / Paste Shortcut

AccuTerm supports standard Copy and Paste functions using the Edit menu
or the context (right-click) popup menu. Y ou can a so choose shortcut keys
for these functions: CTRL + INS / SHIFT + INS or CTRL + C/ CTRL + V.
However, if you select the shortcut you will no longer be able to use the
normal function of the shortcut keys. For example, if you select CTRL + C/
CTRL + V for your Copy / Paste shortcut, you will not be able to send the
CTRL + C control character anymore.
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Printer Settings

AccuTerm 2K 2 uses the printer in two ways: First, AccuTerm can print the
contents of the terminal screen by usingEile Print Screen menu command
(or toolbar button), theALT + G keyboard command, or by receipt of the
appropriate command from the host computer.

The other way AccuTerm uses the printer isto emulate a“slave” printer
attached to aterminal’s Aux (printer) port. This mode is enabled by using
the File Printer On menu command, the ALT + P keyboard command, or by
receipt of the Printer On command from the host. The state of the “dave
printer” is indicated on the status bar (Idle, Off or On).

When AccuTerm receives aPrinter On command from the host (or by using
the Eile Printer On menu command or ALT + P keyboard command), the
printer status shown in the status bar is changed toOn. When the Printer Off
command is received, the status changes to Off. If another Printer On
command is not received before the number of seconds specified inPrinter
Close Timeout, the print job is closed, and the status changestoldle.

AccuTerm can print in two modes: text and graphics. Text is the mode used
by “real” terminals. This mode is different from normal Windows printing in
that the Windows printer driver is not used. For screen printing, text mode
sends the screen text to the printer. For slave printing, AccuTerm passes raw
data, including control characters and escape sequences from the host
directly to the printer (or spooler). In text mode, the host computer is
responsible for setting printer font sizes and page orientation by sending the
appropriate printer commands.

In graphics mode, AccuTerm prints an image of the screen on the printer,
using the Windows printer driver. When the screen is printed in graphics
mode, the printed image includes text, line drawing characters, any images
displayed on the screen, and may optionally include the screen background
and colors. For slave printing, AccuTerm understandscr (carriage return),
LF (line feed) and FF (form feed) control characters, but other control
characters and escape sequences are ignored.
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Y ou can select the paper size and page orientation used for graphics mode
printing by clicking the Page Setup button in the printer settingstab. For
dave printing in graphics mode, you can also select the font.

AccuTerm can also useprint adapter scriptsto process slave print jobs. See
below for details.

Printer Selection

By default, AccuTerm uses the system default printer (theUse Windows
Default Printer option selected). If you want to select a different printer,
select the Use Specific Printer option, then select a printer from the drop-
down list. If you want to disable printing from AccuTerm, select theDisable
printing option.

Screen Print Settings

AccuTerm can print the screen in Text or Graphics modes. In Text mode,
only the text characters currently displayed on the screen are printed. In
Text mode, you can elect to g ect the page from the printer before the
printout, after the printout or both.

In Graphicsmode, an “image” of the current screen is printed, including
special symbolslike line drawing characters. Y ou can elect to print the
background (shading and highlighting) or print the screen incolor if you
have a color printer. In Graphics mode, you can select the page orientation,
paper size and paper source by clicking the Page Setup button.

Slave Printer Settings

AccuTerm can print to the lave printer in either Text or Graphics mode. In
Text mode, you can g ect the page from the printer before the printout, after
the printout or both. In Graphics mode, you can select the font, page
orientation, paper size and paper source by clicking thePage Setup button.

If you have configured any print adapter scripts (see below), you can select
one of these as well. See the discussion above for the differences between
text and graphics modes.
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Printer Close Timeout

Enter the number of seconds to wait after receiving aPrinter Off command
before closing the print job. Usually, when the host computer needs to print
areport, it usually sends aPrinter On command, sends the printer data and
then sends aPrinter Off command. But some host programs send aPrinter
On command, send some data to the printer, send aPrinter Off command,
and send some other data to the screen, and then send another Printer On
command, and send more data to the printer, etc. Because of this, AccuTerm
has no way of knowing when the host is finished sending the print job. The
only way it can determine thisisto wait for a set amaunt of time after the
Printer Off command before closing the job. If thisfield is set to the default
of 5 seconds, AccuTerm waits 5 seconds after thePrinter Off command has
been received before closing the print job.

This causes a delay when printing under AccuTerm. If all your host
programs always turn the aux port on, send all the data and then turn it off,
you can reduce this number to 1 or 0. If you have programs that are
constantly turning the aux port on and off, you may need to adjust this
number until things work correctly.

Print Adapter Configuration

For dlave printing, AccuTerm can utilize aprint adapter script to process a
print job (file). The adapter script can launch command-line print utilities
such as PrintWizard (from Rasmussen Software). PrintWizard can print
jobs that contain Hewlett Packard PCL on most any Windows printer, even
if the printer does not have native PCL support. Thisis quite useful if you
use PCL-formatted reports and forms in your application, but have newer
printers without PCL (or even text) support. Click theClick hereto
configure print adapter slink on the Printer tab to choose available print
adapters, then select the desired adapter from the dropdown list n the
Printer tab. If you have PrintWizard installed on your PC, you can select
the included PrintWizardPCL adapter script to enable PCL printing on non
PCL compatible printers. Y ou can also create your own custom adapter
scripts, using the supplied PrintWizardPCL .atsc script as an example. Using
this feature, you can use external programsto convert your slave printer
reports and formsto PDF files email or fax.
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File Transfer Settings

AccuTerm supports several file transfer protocols. TheFile Transfer tab
allows you to adjust some of the parameters used control the various
protocols, select default operating modes and specify default directories.
There are sections for ASCII options, X/Y/Zmodem options, Kermit
options, as well as options for default modes and directories. The default
values for most of these options should not be changed without an
understanding of the protocol and the companion file transfer program on
the host computer.

ASCII Settings

When transferring a file from your computer to the host computer (upload)
using the ASCII protocol, the each line may be terminated with acr, LF or
CR LF combination. Select the appropriate end of linefor the host computer
by checking the appropriate button.

ASCIl isa“blind” protocol. The receiving computer cannot inform the
sending computer when it is safe to transmit data. In order to perform
reliable ASCII uploads, you may need to specify an appropriatel nterline
delay time. After each lineis sent to the receiving computer, AccuTerm
will wait for the specified time before sending the next line. Specify this
value in milliseconds.

Note: the Interline delay setting also appliesto the Edit Paste and Edit
Paste From commands.

Timeout Settings

When using any of the X/Y/Zmodem protocols, you can specify the number
of seconds before atimeout occurs. If the other machine fails to respond
within the number of seconds specified here, the protocol will attempt to
resend the previously sent message.
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Kermit Settings

The Kermit file transfer protocol is popular with minicomputer and
mainframe systems. There have been many revisions of this protocol, and it
may be necessary occasionally to modify some of these settings to
communicate with another Kermit program.

Kermit settings: Defaults

These default options may be set (checked) or reset (un-checked) as desired.
When AccuTerm Kermit is negotiating with the other Kermit program, any

of the checked options will be requested, and if the other Kermit is capable,
the option will be used.

Quote eighth bit: select this option when the communications path
only supports 7 data bits, or when the other machine is not capable
of processing eight bit data.

Compress data: selecting this option causes Kermit to perform
rudimentary data compression. Not all Kermit programs perform
data compression.

CRC block check: select this option to use CRC error detection
instead of the standard simple checksumerror check. This results
in more reliable transfers, especially over noisy phone lines. Not
all Kermit programs perform CRC error checking.

Default Mode

Select Text or Binary as the default transfer mode (used only for Kermit
and Zmodem protocols). When you select Upload or Download from the
main menu or toolbar, the default mode will be selected. Also, select
whether to overwrite existing files when downloading. Y ou also can change
any of these options in the Upload or Download dialog before performing
the transfer.

Default Upload/Download Directory

Enter the drive and directory where you want received files to be stored by
default. Y ou can change this directory in the Download dialog before
performing the transfer. If you set theAutomatic Zmodem download
option, then thisis the directory where the received files are stored.

Configuring AccuTerm 61



Automatic Zmodem Download

If thisoption is set, then AccuTerm will automatically begin receiving files
using the Zmodem protocol when the other machine begins sending files
using the Zmodem protocol. The files are saved in theDefault
Upload/Download directory.
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M iscellaneous Settings

The Miscellaneous Settings tab is used for setting various options, such as
how paste operations are handled and the sound of the terminal bell.

Paste Options: line end

When the clipboard is “ pasted” to an AccuTerm session, AccuTerm
transmits the clipboard text to the host computer. Theline end options
specify what is transmitted at the end of aline of text. Options includecr
(default), LF, CF+LF, TAB, none or a user-defined character. To specify a
user-defined character, select theUser defined option and enter the ASCII
code of the character to be transmitted at the end of each line.

Paste Options: do not send line end after last line
If you want to suppress the final end-of-line (or only end-of-line if only a
singlelineisin the clipboard), select this option.

Paste Options: paste end

After pasting the clipboard to an AccuTerm session, AccuTerm can transmit
an optional paste end character. Normally, AccuTerm does not transmit any
character at this time, but you can select EOF (which isthesuB or CTRL +
Z control code), or a user-defined character. To specify a user-defined
character, select theUser defined option and enter the ASCII code of the
character to be transmitted at the end of a paste operation.

Terminal Bell Sound

The sound generated by AccuTerm upon receipt of the ASCIIBEL control
code can be customized. Thedefault sound depends upon whether a sound
card isinstalled or not. If asound card is not installed, a“beep” is produced;
otherwise the sound defined by the Control Panel “ Sounds” applet as the
“Default Beep” is played.

Other options which may be selected are: play wave file, system event,
beep or silent. To play awavefile, select this option and enter the full path
for the wave file to be played. To use a sound associated with a system
event, select the event from the dropdown list. System events are associated
with wave files in the Control Panel “ Sounds” applet. To use atrue beep,
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enter the frequency of the beep in Hz, and the duration in milliseconds. The
default is 400Hz for 500ms. The frequency must be between 200Hz and
4000Hz. The duration must be between 100ms and 5000ms.

Advanced (Custom Features)

Click the Advanced button to show any custom features that can be
selected. See the Programmer s Guide for more information on the custom
features of AccuTerm 2K2.
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AUTO DIALER

The AccuTerm Auto Dialer gives you an easy way to store and dial phone
numbers. The Phone directory list contains al the phone numbersin the
current directory file. Y ou can have as many phone numbersin a directory
file as you want. Y ou can also have any number of directoryfiles. The
default directory file nameis set in theGeneral tab of the Settings dialog
box (Tools Settings menu).

To accessthe Auto Dialer, select theT ools Dialer menu item or click the

button on the tool bar.

Note: the Auto Dialer is only availableif the current session is configured
to use a Modem for its connection.

Dialing

Using the Auto Dialer isvery ssmple. To dial a number, double click an
entry in the phone directory, or higHight the desired number in the phone
directory list then click the Dial button.

If you want to dial anumber which is not in the directory, simply enter the
desired phone number in the Number field, then click Dial.

Hanging Up
To terminate a connection, click the Hang Up button.

Adding a new entry
To add anew entry to the directory, click on theNew button. Enter a phone
number and optional description, then click theAdd button.

Deleting an entry
To delete the selected entry, click the Delete button.
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Modifying an entry
To change an existing description or number, select the entry you want to
change, modify the description or number and click theEdit button.

Creating a new directory file

To create a new phone directory file, click the Change Directory button.
From the Open Phone Directory Filedialog, select the drive and directory
for the new phone directory file, and enter the new phone directory file
name. Click OK to create the new phone directoryfile.

Changing directory files
To select adifferent phone directory file, click theChange Directory
button, then select the new phone directory file. Click OK.

Changing dialing options

To change the dialing options such as your current location, area code,
dialing prefix, credit card information, etc., click theDialing Options
button.

Directory file format

Phone directory entries are stored in a standard tab delimited ASCII text file
with afile extension of .dat. The name isthefirst field and the phone
number is the second field. Each entry hasits own line. Many applications
have the ability to export datato ASCII files so it may be possible to use
your existing phone directories from other applications with the Auto Dialer.
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FILE TRANSFER

AccuTerm has the ability to transfer files between your computer and a
remote machine using one of the five built in file transfer protocols: ASCII,
Kermit, Xmodem, Y modem and Zmodem. The standard (non-MultiValue)
file transfer functions are accessed from theT ools menu by selecting the

Upload or Download items or by clicking on the or buttons on

the toolbar, then selecting M anual Download from the selection panel.

For MultiValue users, AccuTerm 2K2 includes aFile Transfer Wizard that
simplifies the file transfer process by asking a series of simple questions and
letting you click, enter or browse for the answers. To start theFile Transfer
Wizard, select Upload or Download from the T ools menu or by click on

the or [ &5 | buttons on the toolbar, then select Upload Wizard (or
Download Wizard) from the selection panel. In order to use the File

Transfer Wizard, the AccuTerm 2K 2 host programs must be installed on
your MultiVaue host system.

AccuTerm also includes command-line style file transfer utilities for
MultiValue systems. These utilities are installed along with the host
programs. For users of MultiValue based systems, using theFile Transfer
Wizard or the command-line utilities is the recommended method of
exchanging data between your PC and the host computer.
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Installing the MultiValue Host Programs

The AccuTerm host programs for MultiVaue systems are written entirely in
BASIC. AccuSoft recommends that the host programs be installed into a
dedicated account (usually the ACCUTERM account) on your host system.
Once installed, the programs can be shared with other accounts on the
system. Toinstall the host programs on your MultiValue system, perform
the following steps:

1) Open atermina session and connect to your MultiValue host
system. Log on to the ACCUTERM account, or another account
where you want to install the AccuTerm host programs. Check the
following items before beginning the installation:

a)
b)
c)

d)

€)

f)

9)

Make sure you are at a command prompt (TCL, ECL,
etc.)

If your system hasa“case invasion” feature, disable it
(PTERM CASE NOINVERT).

If your system blockscontrol characters, disable the
blocking (CONTROL-CHARS ON).

If your system is running on a Unix or Linux host, make
sure that the CTRL + A control character can be input.
Check by typingstty -a at aUnix prompt—look for
AA - if you find it, either disable that function or map it to
adifferent control character. For exampleif you see
something likesusp = AAyoucantypestty susp
\A- to disable the suspend function.

Enable type-ahead. Most systems have type-ahead enabled
all the time, however you might need to enable typeahead
on a per-port basis on some systems (TA-ON or
TYPEAHEAD-ON).

If you areinstalling on a jBase system, be sure you have
an MD file, and that your terminal type is set correctly
before installing the host programs.

Check the Paste Options— Line End setting in the
Settingsdialog, Misc tab and ensure that the “CR” option
is selected. Ensure that the “ Do not send line-end
after...” option isnot selected.
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2)

3

4)

Browse to the PickBP folder.

FTPINST. TXT
FTPINSADDS.TXT
FTPINSAP.TXT
FTPINSAP_AIX.TXT
FTPINSAP_PRO.TXT
FTPINSD3.TXT
FTPINSD3_AIX.TXT
FTPINSENH.TXT

FTPINSIB.TXT
FTPINSIB_AIX.TXT
FTPINSMD.TXT
FTPINSMV.TXT
FTPINSNR.TXT
FTPINSOI.TXT
FTPINSON.TXT
FTPINSPWRO95. TXT
FTPINSQM.TXT
FTPINSR83.TXT
FTPINSSEQ.TXT

FTPINSSEQ_AIX.TXT
FTPINSUD.TXT
FTPINSUD_AIX.TXT
FTPINSULT.TXT

FTPINSULT_AIX.TXT

While at the command prompt (TCL, ECL, etc.), click on theEdit
menu and select Paste From.

Click on the install script for your platform (please see the
readme.txt file in the PickBP folder for the latest platform list):

generic MultiValue system
Mentor, Mentor Pro, MOE
Advanced Pick

Advanced Pick on AIX

Advanced Pick / Pro

D3 (NT, Linux, Unix except AlX)
D3 onAlX

Enhanced R83 (Altos, Fujitsu, R91,
etc.)

jBase

jBaseon AlX

Reality

mvBase

Northgate Reality 9+
Revelation Openinsight CTO
ONWare MVON

Power 95

QM MV Database

Pick R83

Sequoia, mvEnterprise (except
Ultimate emulation)

Sequoia, mvEnterpriseon AlX
UniData

UniData on AlX

Ultimate Plus (all except SCO Unix
and Al X)

Ultimate Plus on Al X
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FTPINSULT_SCO.TXT Ultimate Plus on SCO Unix
FTPINSULTX.TXT Early Ultimate (as implemented on
mvEnterprise)

FTPINSULTX_AIX.TXT Early Ultimate (as implemented on
mvEnterprise) on AlX

FTPINSUV.TXT UniVerse
FTPINSUV_AIX.TXT UniVerseon AlX
FTRPINSVIS.TXT UniVision

5) Click the Open button. AccuTerm will install a small PROC and
bootstrap program which will be used to install thecorefile
transfer programs. Y ou will see the PROC and bootstrap programs
asthey are entered into the host MD and FTBP files. Once the
bootstrap program has been installed, it will run automatically and
complete the ingallation of the core programs (FTBP file).

Once the main host programs are installed, a dialog box will be
displayed where you can select any optional program libraries
(GUI, ObjectBridge, SUI) and sample programs and data that you
want to install.

6) If you have previously installed the ViaDuct host programs, the
ViaDuct FT proc conflicts with AccuTerm’'s FT program. If this
conflict is detected, the AccuTerm installer will prompt if you want
to rename the ViaDuct FT command as“FT.VIA”. AnswerY to
rename.

7) If need to reinstall the host programs, or install an updated version,
or would liketo install any of the optional libraries at alater time,
just type LOAD-ACCUTERM-PROGS at TCL and select the
desired options from the dial og.
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Activating Other Accountsto usethe Host Programs

After installing the host programs on one account on your host system
(usually the ACCUTERM account), you can easily activate these programs
on other accounts. To activate the programs on another account, perform the
following steps:

1) Logontothe ACCUTERM account (or other account where you
have installed the host programs).

2) AtTCL, type FTSETUP. The FTSETUP program will display a
menu. Enter 1 (Account Setup) and pressENTER.

3) When prompted for the account name to activate, type the name
and pressENTER.

4) TypeX and pressENTER to quit the FTSETUP program.
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MultiValue File Transfer

To make the mog effective use of AccuTerm with your MultiValue host
system, you should install the AccuTerm host programs. These programs
implement the Kermit and ASCI| file transfer protocols, coordinate the
transfer of data between your computer and the host, import and export data
in avariety of formats, provide a simple host-to-host transfer facility, and
enable the use of the wED program and text editor.

In order to understand how to best use AccuTerm’s MultiValue file transfer
features, the differences between the PC and MultiValue file systems must
be examined. Traditional PC files may be programs, documents or data
files; in the typical MultiValue system, programs and documents are stored
asindividual items (records) in afile, whereas adatafile is collectian of
related items (records) in afile, with an associated file dictionary.

When exchanging data between your computer and your MultiValue host, it
isimportant to realize the difference between “document files’” and “data
files’.

Although AccuTerm supports both Kermit and ASCII protocols, Kermit is
the recommended file transfer protocol because of the automatic error
detection and correction. Also, even with the increased overhead ensuing
from Kermit, because the sender and receiver are synchronized and no time
delays are required, the Kermit protocol usually performs better than the
ASCII protocol when receiving afile.

File Transfer Wizard

After installing the AccuTerm host programs, you can use theFile Transfer
Wizard to exchange data between your MultiValue host and your PC.To
start the File Transfer Wizard, select Upload or Download from the T ools
menu or by click on the| 4| or | &3] | buttons on the toolbar, then select

Upload Wizard (or Download Wizard) from the selection panel. Y ou can
also start the wizard by using the FTWIZ verb at TCL.
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TheFile Transfer Wizard will guide you through the download or upload
process by displaying a series of small panels, with simple questions on
each. Simply fill in the answers or click on the desired options. When you
get to the last step, you can click the Run Job button to execute the transfer.
You can aso save the job to afile on your host or o local file on your PC.
Thisway, you can reuse the same job over and over, and can even automate
atransfer by using the FTWIZ verb with a saved job:

FTWIZ filename jobname (R
While using the wizard, you can use theNext and Back buttons to move

between steps. Online help is available for each step in the wizard; just click
the Help button.

File Transfer 73



Command-Line File Transfer Utilities

When transferring “ document files” between the PC and MultiValue host,
use AccuTerm’sFT utility. Thisutility transfers MultiValueitemsto PC
filesand vice versa. The key concept is that eachMultiValue item becomes
a separatefile on the PC.

When transferring “ data files” between your PC and your MultiValue host,
usethe FTD utility. Thisutility transfers a set of MultiValueitemsto a
single PC file and vice versa. The key concept isthat aset of items on the
host becomes asingle file on the PC.

You can aso use AccuTerm to transfer data between two MultiValue hosts.
The FTPICK utility isused to transfer data from one MultiValue machine
to another, either directly (using two concurrent AccuTerm sessions), or
using an intermediate PC file.

Downloading Documentsto Your PC

UsetheFT utility to send items (documents) from your MuttiValue host to
your PC. FT downloads each item (document) into a separate PC file.
Normally, FT uses text mode, converting attribute marks to CR/LF during
the download process.

To download using FT, enter FT at the command prompt. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

Answer S to send, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?
Kermit is recommended.

Enter source (Pick) file name:

74 File Transfer



Enter the name of the host file which contains the items to be sent.

Enter source (Pick) item list:

Enter the item-1Ds to be sent. If you do not enter item-1Ds, any previously
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter
an asterisk (*), all itemsin the file will be transferred. To specify a saved
list, enter an open parenthesis followed by the list name. Separate itemIDs
with blanks.

Enter target (DOS) directory name:

Enter the PC directory name including drive letter if desired. Separate
directory namesin afull path using back-dlashes. UNC-style file names are
acceptable.

Enter target (DOS) file name:
Enter the PC file name, including extension. If multiple items are being
sent, multiple file names may be specified here. Each host item will be
written to a separate PC file. If no file names are specified here, the itemID
will be used as the PC file name.
When the transfer is complete, you may see a message like:

Converting file to ANSI character set ...

Thisindicates that the raw data hasbeen downloaded and is being converted
from the OEM character set to the ANSI (Windows native) character set.
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Uploading Documents from Your PC to the Host
UsetheFT utility to send PC files to your MultiValue host. Each PC file
uploaded is saved as anitemin the host file you specify.

To upload using FT, enter FT at the command prompt and follow the
prompts.

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

Answer R to receive, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?
Kermit is recommended.

Enter source (DOS) directory name:
Enter the name of the PC directory which contains the files to be uploaded.

Enter source (DOS) file name:

Enter the name(s) of the PC file(s) to be received. Separde multiple file
names with blanks. Wildcard characters (? and *) are valid.

Enter target (Pick) file name:

Enter the host file name where the uploaded files are to be saved. Each
uploaded fileis stored as anitemin thisfile.

Enter target (Pick) item list:

Enter the item-1D(s) for the uploaded file(s). If multiple files are being
uploaded, multiple item-1Ds may be specified here. If no itemIDs are
specified here, the PC file name will be used as the itemID.

Before the transfer begins, you may see amessage like:
Converting file to OEM character set ...
Thisindicates that the PC file, which uses the ANSI (Windows native)

character set is being tranglated into the OEM character set prior to transfer
to your host computer.
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FT Optionsand Settings

Severa configuration (permanent) and option (temporary) settings are
available for the FT utility. The permanent configuration settings are used
as the default values for the temporary option settings.

FT Configuration Settings
To change configuration (permanent) settings, enter C in response to the
first prompt. A list of configuration settings will be displayed:

Current parameter settings are:

1. Transfer mode Text

2. Preserve file extension Yes

3. Overwrite existing item Yes

4. Large item treatment Truncate
5. Convert OEM char set to ANSI No

Enter parameter number (1-5) to modify:

The setting for any of these items may be changed by entering the item
number and pressing ENTER..

Transfer Mode
Possible transfer modes aretext and binary. Text causes attribute mark
charactersto be trandlated to carriage return / line feeds and vice versa.

Preserve File Extension

When the Preserve File Extension option is enabled, DOS files that are
uploaded retain their extension. That is, if you upload afile called
REPORT.TXT, theitem ID used to store the uploaded file is
REPORT.TXT. If this option is not enabled, the item ID used would simply
be REPORT.

Overwrite Existing Item

When the Overwrite Existing Item gption is enabled, any existing file
(download) or item (upload) will be overwritten with the new data. If the
option is disabled, existing items are not overwritten.

Large ltem Treatment

Large Item Treatment may be set to truncate items at about 30000 bys,
split large items into multiple items of about 30000 bytes each, or no action
(for those systems with no item size limitation). Split items use a special
item-id generated by concatenating the original item-id, an underscore (),
and a sequential number starting with 001.
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Convert OEM Char Set

If you enable OEM/ANSI character set conversion, the file you upload or
download is atemporary file. The actua file is converted before uploading
and after downloading. Y ou should not enable this option unlessyou use
international characters on your MultiValue host, and those characters are
stored using the OEM character set (the set used by ADDS Viewpoint,
Wyse, ANSI BBS and PC Monitor emulations).

FT Option Settings

To change option settings, enter O in response to the first prompt. A list of
option settings will be displayed. Note that the default value of the options
is obtained from the configuration settings:

Current parameter settings are:

1. Transfer mode Text
2. Preserve file extension Yes
3. Overwrite existing item Yes

The setting for any of these items may be changed by entering the item
number and pressing ENTER..

An aternate way to set the value of an option setting is to answer the prompt
with the item number, an equal sign, and the first letter of the value to which
the parameter isto be set. For example, to set the Transfer Mode to
“binary”, respond to “Enter parameter...” with1=B. This alternate method
isuseful in cases where theFT utility is being “driven” by a PROC or by
another program using the EXECUTE statement.

The meanings of these option settings are the same as the configuration
settings described previoudly.
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Downloading Data Filesto Your PC (Export)

Usethe FTD utility to download a set of specified (or selected) items from
your host database to a PC file. Y ou can specify which fields (attributes) to
download. Thetarget PC file format is determined by the file name you

specify.

FTD can also be used to join several host itemsinto asingle PC file. Thisis
done by setting the field delimiter to* CrLf", and entering an asterisk at the
“Source item list” prompt

To export data from the host using FT D, enter FTD at the command prompt,
then answer the prompts. Ontline help is provided for each prompt, just
enter a question mark and pressENTER.

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

Answer S to send, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?
Kermit is recommended.

Enter source (Pick) file name:
Enter the name of the host file which contains the data to be exported.

Enter source (Pick) item list:

Enter the item-1Ds of the items (records) you want to export. 1f you do not
enter any item-IDs, any previoudly selected (SELECT, GET-LIST, etc.)
items will be exported; if you enter an asterisk (¥), al itemsin the file will
be exported. To specify a saved list, enter an open parenthesis followed by
thelist name. Separate item-IDs with blanks.

Enter target (DOS) file (path) name:

Enter the full PC file name including drive letter and directory, if desired.
Separate directory names in the path using back-slashes. UNC-style file
names are acceptable.

For certain file types (Excel, Access, etc.), you may need to append a
modifier after the file name; see the discussion of file types at the end of this
section for details.
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Attributes to transfer:

Enter thelist of fields, or attributes, to be exported. Enter either the
attribute number or attribute name as defined in the file dictionary. An
asterisk (*) may be entered here to export al attributes (including the Item
ID), from all selected items. A plussign (+) may be entered to export all
attributes except the Item-1D.

Generate Header Record (<Y>/N):

Answer Y if you want the first record in the PC file to be a*“header record”.
The header record specifies the names of the fields of each datarecord in
the file and may be used as column or field identifiers by certain Windows
applications. If an asterisk was entered for the attribute list, the header
record will contain only an asterisk.

If asterisk was not entered for the attribute list,

Explode MultiValue Fields (Y/<N>):
Answer'Y to explode all multi-valued fields. When multi-valued fields are
exploded, a separate data record will be created for each multivalue, with
any single-valued fields repeated for each multi-value. When multi-valued
fields are not exploded, the value-mark characters remain in the data and
appear as an accentedy.
When the transfer is complete, you may see a message like:

Converting file to Excel file format ...

Thisindicates that the raw data has been downloaded and isbeing formatted
in the native file format indicated by the file name you entered.
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Uploading Data Files From Your PC tothe Host (Import)

Usethe FTD utility to import data from afile on your PC to your
MultiValue database. The PC file being imported should be a“ database”
such as a spreadsheet, delimited text file, html table, Access database or
other database format recognized by AccuTerm.

Toimport datausing FTD, enter FTD at the command prompt and follow
the prompts.

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

Answer R to receive, then select the file transfer protocol:
File transfer protocol: (A)SCII or (K)ermit ?
Kermit is recommended.

Enter source (DOS) file (path) name:

Enter the full PC file name including drive letter and directory, if desired.
Separate directory names in the path using back-slashes. UNC-style file
names are acceptable.

For certain file types, you may need to append a modifier after the file
name; see the discussion of file types at the end of this section for details.

Use Header Record (<Y>/N):

Answer Y if you want the use the first record in the PC file as a“ header
record”. The header record specifies the names (or numbers) of the
attributes to be imported. If the header record consists of a single asterisk,
all fields (attributes) in each record are imported. If you answerY to this
prompt, the next prompt will be “ Enter target (Pick) file name”; other
prompts will be bypassed.

Attributes to transfer:

Enter the list of attributes (fields) to be imported. Enter either the attribute
number or attribute name as defined in the file dictionary. An asterisk may
be entered here to import all attributes (entire record or item). The
attributes must be listed in the order that the fields appear in the source
database or file. If you do not want to import a particular field, you can
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enter adash ( - ) instead of an attribute nameto skip that field. Attribute
definitions containing A or F correlatives cannot be specified.

Number of header records to skip:

Enter the number of records at the beginning of the PC file which are to be
considered “header records’, which should to be ignored when importing
thefile.

Automatically generate target (Pick) IDs
(Y/<N>) :

Answer Y to generate item-1Ds for each record. If theitemID is not
specified in response to the “ Attributes to transfer” prompt, youmust
generate item-IDs. The generated item-1D consists of a constant (possibly
null) prefix, followed by a sequential number. If item1Ds are not generated,
the next two prompts will be skipped.

Auto ID Prefix:

Enter the constant item-ID prefix. Null is acceptable if the generated item
ID issimply a sequential number.

Auto ID Starting Number:
Enter the starting value for automatically generated itemIDs.

Enter target (Pick) file name:
Enter the name of the host file where the imported data is to be stored.
Before the transfer begins, you may see a message like:

Converting file from Excel format for upload
Thisindicates that the PC file datais being converted into a delimited

ASCII format which can be imported to your MultiValue database prior to
transfer to your host computer.
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File Typesfor Import and Export

The default file format used by theFTD utility is ASCII delimited text. In
this format, records in the PC file are separated by a carriage return / line
feed and fields are separated by tebs or commas. If the field delimiter isa
comma, then each field is enclosed in quotation marks. Embedded
guotation marks are duplicated. Thisfile format is easily imported by many
Windows database and spreadsheet programs.

Certain file extensions arerecognized by AccuTerm and are assumed to be a
particular format. These extensions are:

.db2 dBase 1

.dbf dBase I11/1V

.htm, .html HTML table

.mdb Microsoft Access database
.Sym L otus Symphony

whbl Quiattro

wk1 Lotus vl-v2

wks Lotus v3-v5

Xl, xls Microsoft Excel

Import and Export from Excel

When accessing Excel workbook files, theFTD utility has the ability to
reference explicit worksheets and ranges of cells. To use this feature, specify
the Excel file name as:

d:\path\file.xls!sheet!range

whered: \path\file.x1ls isthe path of the Excel file, sheet isthe
worksheet name or tab number (sheet may be null to use the first
worksheet in the workbook), range istherange of cellsto access. Either a
named range may be used or acell location (e.g. A4) or cell range (e.g.
B3:F42) may be specified.

When exporting data to Excel, the range identifies the upperleft cell of the
target worksheet; the number of colunns and rows is determined by the data
being sent.

When importing data from Excel, the range specifies the entire block of data
to be imported. To specify only the upper-left corner of the block (the
number of columns and rows determined by the extent of he worksheet),
follow the cell with atrailing colon (e.g. B3).
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When downloading to an Excel worksheet, the setting of the Overwrite
option changes how AccuTerm stores the data.

No Overwrite: if the Excel file exists, and no worksheet has been specified,
the transfer is aborted with an error. If aworksheet has been specified, and
the worksheet exists, the transfer aborts. If the file does not exist, or if it
exists but a new worksheet is specified, the transfer proceeds.

Overwrite: if both aworksheet and range are specified, cells in specified
range are overwritten with new data. If only a worksheet is specified, the
entire worksheet is replaced with new data. If only arangeis specified, the
cellsin the specified range in the first worksheet are overwritten with new
data. Otherwise, anew file or worksheet is created.

Merge: if the Excel file exists, and no worksheet is specified, a new
worksheet is created. If aworksheet is specified, but arange is not, new
cells are added to the end of the spedfied worksheet. If both worksheet and
range are specified, new data replaces the specified range.

Import and Export from Microsoft Access

When accessing Microsoft Access tables, you must specify the table name in
addition to the database file name. Y oumay also need to specify a
connection string with your password to access the desired data source. To
specify these items, enter the Access database file name as:

d:\path\file.mdb!table!connection

whered: \path\file.mdb isthe path of the Access databasefile,
table isthe table namein the database, connection isan optional
string that may be necessary to connect to some data sources.

When downloading to an Access database, the setting of the Overwrite
option changes how AccuTerm stores the data.

No Overwrite: if the Access database file exists, and the specified table
exists, the transfer is aborted with an error. Otherwise the table is created in
the specified file.

Overwrite: if the specified table existsin the databasefile, the tableis
cleared and new records are added to the table. If the table does not exist, it
is created.
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Merge: if the specified table exists, new records are added to the table.
Otherwise anew tableis created.

FTD Optionsand Settings

Severa configuration (permanent) and option (temporary) settings are
available for the FTD utility. The permanent configuration settings are used
as the default values for the temporary option settings.

FTD Configuration Settings
To change configuration (permanent) settings, enter C in response to the
first prompt. A list of configuration settings will be displayed:

Current parameter settings are:

1. Preserve file extension Yes

2. Overwrite existing item No

3. Large item treatment No action
4. Field delimiter Tab

5. Convert OEM char set to ANSI No

Enter parameter number (1-5) to modify:

The setting for any of these items may be changed by entering the item
number and pressing ENTER.

Preserve File Extension
Thisitemis not used by the FTD utility.

Overwrite Existing Item

This option can be used to protect existing files and items from being
overwritten. Select “Yes’ to allow existing DOS files to be overwritten
during downloads (host to PC), or existing items to be overwritten during
uploads (PC to host). Select “No” to protect existing files (downloads) or
items (uploads). Set to “Merge” to append or merge data into existing files
during downloads.

Large ltem Treatment
Thisitem is not used by the FTD utility.
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Field Delimiter

Thefield delimiter (PC file) may be set to “Tab”, “Comma’, “CrLf” or any
user-defined string. When you select “Comma’ as the delimiter, AccuTerm
encloses each field in quotation marks. “CrLf” can only be used for
exporting data to the PC (when importing, the field andrecord delimiters
must be different). User-defined field delimiter is entered in hex, at the
“Enter parameter..” prompt, asin4=1A.

Convert OEM Char Set

If you enable OEM/ANSI character set conversion, the data is converted to
the OEM character set before upload, and to the ANSI| set after download.

Y ou should not enable this option unless you use international characterson
your MultiValue host, and those characters are stored using the OEM
character set (the set used by ADDS Viewpoint, Wyse, ANSI BBS andPC
Monitor emulations).

FTD Option Settings

To change option settings, enter O in response to the first prompt. A list of
option settings will be displayed. Note that the default value of the options
is obtained from the configuration settings:

Current parameter settings are:

1. Preserve file extension Yes
2. Overwrite existing item No
3. Field delimiter Tab

The setting for any of these items may be changed by entering the item
number and pressing ENTER.

An alternate way to set the value of an gption setting is to answer the prompt
with the item number, an equal sign, and the first letter of the value to which
the parameter isto be set. For example, to set the Field Delimiter to “ Tab”,
respondto “Enter parameter...” with 3=T. Thisalternate method is
useful in cases where the FTD utility is being “driven” by a PROC or by
another program using the EXECUTE statement.

The meanings of these option settings are the same as the configuration
settings described previoudly.
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Transferring Data Between MultiValue Hosts

The FTPICK utility will transfer specified (or selected) items from one
MultiValue computer to another. Thistransfer can be donein one step if
you have two AccuTerm sessions open, connected to each of the MultiValue
host computers. AccuTerm will also let you transfer data from one host to
another using an intermediate file stored on your PC. Thistransfer requires
two steps: transfer from first host to intermediate PC file, then transfer from
the intermediate file to the other host.

Direct Host-to-Host (One Step) Transfer

The direct transfer requires two sessions running on AccuTerm- one session
connected to the source host (sending machine), ard one session connected
to the target host (receiving machine). If you cannot run two sessions, you
must use an intermediate PC file to store the data temporarily using the two
step method (see next section).

Tousethe FTPICK direct transfer method, activate the AccuTerm session
connected to the target host, and start FTPICK. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

Answer R to receivefiles, then select the direct mode:

Receive (D)irectly from PICK file or from
(I)ntermediate DOS file ?

by answering D. A pandl titled “AccuTerm Pick-to-Pick File Transfer” will
be displayed on the target screen. Y ou can cancel the Hostto-Host transfer
at any time by pressing theESC key while the target session is active.

Next, activate the AccuTerm session connected to the source host, or
sending machine, and start FTPICK. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

answer S to send files. Then enter the name of the source host file to be
sent:
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Enter PICK source file name:

Enter the name of the source host file which contains the items to be sent.

Enter source (Pick) item list:

Enter the item-IDs to be sent. If you do not enter item-1Ds, any previously
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter
an asterisk (*), all itemsin the file will be transferred. To specify a saved
list, enter an open parenthesis followed by the list name. Separate itemIDs
with blanks.

Send (D)irectly to PICK file or to
(I)ntermediate DOS file ?

Answer D to send thefile directly to the target machine.

Enter target PICK file name:

Enter the file name on the target machine into which the selected items will
be written.

Once the target file name has been entered, the receiving session will be
activated and the transfer progress will be displayed in the panel. When the
transfer is complete, press theESC key to terminate the receiving FTPICK
program, or activate the sending session to send another file.

Host-to-Host transfer using Intermediate PC File (Two Step)

If you cannot open one session to each MultiValue host machine, or if you
want to send the same file to several target machines, you can save the data
in an intermediate PC file. The procedure is similar to the direct method
described above, except that the send must be done first, and a PC file must
be specified for both the send and receive steps.

Step 1: Transferring From the Source Host to an Intermediate File
Open an AccuTerm session connected to the source machine, and start
FTPICK. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

answer S to send files. Then enter the name of the source file to be sent:

88 File Transfer



Enter PICK source file name:

Enter the name of the source file which contains the items to be sent.

Enter source (Pick) item list:

Enter the item-1Ds to be sent. If you do not enter item-1Ds, any previously
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter
an asterisk (*), all itemsin the file will be transferred. To specify a saved
list, enter an open parenthesis followed by the list name. Separate itemIDs
with blanks.

Send (D)irectly to PICK file or to
(I)ntermediate DOS file ?

Answer I to send the file to an intermediate PC file.

Enter intermediate DOS file name:

Enter the full PC file name of the intermediate file including drive letter and
directory, if desired. Separate directory namesin afull path using back
slashes.

Upon entering the PC file name, the selected items will be transferred to the
specified PC file in a special format used by theFTPICK utility.

Step 2: Transferring From an Intermediate Fileto the Target Host
Open an AccuTerm session connected to the target machine, and start
FTPICK. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions,
(H)elp or (E)xit ?

answer R to receive files. Then enter the name of the intermediate PC file
which contains the desired data:

Receive (D)irectly from PICK file or from
(I)ntermediate DOS file ?

Answer T to retrieve datafrom an intermediate file.

Enter intermediate DOS file name:
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Enter the full PC file name of the intermediate file including drive letter and
directory, if desired. Separate directory namesin afull path using back
slashes.

Enter target PICK file name:

Enter the file name on the target machine into which the retrieved items will
be written.

If the intermediate file isin the correct format, the items contained in the
intermediate file will be transferred and stored into the target host file.

FTPICK Optionsand Settings

One configuration setting (permanent) and option setting (temporary) is
available for the FTPICK utility. To change configuration setting, enterC
in response to the first prompt. A list of configuration settings will be

displayed:

Current parameter settings are:
1. Overwrite existing item Yes

Enter parameter number (1-1) to modify:

The “overwrite existing file” setting may be changed by entering item
number (1).

When using the direct mode, both the sender and receiver must have
“Overwrite existing file” setto“ Yes’ in order for existing items to be
overwritten. If either the sender or receiver has this settings set to “ No” ,
existing items will not be overwritten.

If the receiver has“ Overwrite” setto“ No” and the sender hasit set to
“Yes', the transfer will fail.

To change option setting, enter O in response to the first prompt. A list of
option settings will be displayed. Note that the default vdue of the options
is stored in the configuration settings:

Current parameter settings are:
1. Overwrite existing item Yes

Enter parameter number (1-1) to modify:
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An aternate way to set the value of a configuration or option setting isto
answer the prompt with the parameter number, an equal sign, and the first
letter of the value to which the parameter isto be set. For example, to set
the Overwrite option to “Yes’, respond to “Enter parameter...” with1l=Y.
This alternate method is useful in cases where the FTPICK utility is being
“driven” by a PROC or by another program using the EXECUTE statement.
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Integrating File Transfer Functionsinto
MultiValue Applications

Y ou can integrate AccuTerm’ sfile transfer functions into your MultiValue
application in two ways. First, you can use the commandline utilities from
your BASIC programs or PROCs. To use the command-ine utilities from a
BASIC program, use DATA statements to feed answers to the prompts,
followed by an EXECUTE statement with the desiredcommand-line utility
program. For example, to use the FT utility to send afile from the
MultiValue host to the PC, you might use the following BASIC code:

DATA 'S'

DATA 'K'

DATA 'BP'

DATA ' (LST'
DATA 'C:\MVBP'
DATA "'

EXECUTE 'FT'

The same function in a PROC would look like:

PQ
HFT
STON
HS<
HK<
HBP<
H(LST<
H<

P

Callable subroutines are also provided for use in BASIC programs. The
advantage of calling a subroutine over using EXECUTE (as shown above) is
that the subroutine interface returns a variableindicating the transfer status
(STAT). The following subroutines are available for use by your application
programs:

92 File Transfer



DOSSVC: thisis amulti-function subroutine, combining send— execute —
receive functions. Data to send (or received data) is passed as ar argument
to the subroutine, along with an optional command line to execute beiveen
the send and receive steps

FTS: simplefile transfer. Data to be sent (or received datd) is passed as a
subroutine argument, along with the destination (or source) diredory and
file name, and a mode argument to specify transfer options such as protocol,
direction and overwrite.

FTSEND: send file(s) from host to PC. Specify the source file and item list,
remote directory and optional filelist, and transfer options as stbroutine
arguments. Transfer status returned in STAT argument. This subroutine
performs the same function as the FT command.

FTRECV: receivefile(s) from PC to host. Specify the sourcedirectory and
filelist, destination host file and optional item list, and transfer options as
subroutine arguments. Transfer status returned in STAT argument. This
subroutine performs the same function as the FT command.

FTEXPORT: export data from host to PC. Specify the source file and item
list, remotefile, attribute list and transfer options as subroutine arguments.
Transfer status returned in STAT argument. This subroutine performs the
same function asthe FTD command.

FTIMPORT: import data from PC to host. Specify the source file,
destination host file, attribute ligt and transfer options as subroutine
arguments. Transfer status returned in STAT argument. This subroutine
performs the same function as the FTD command.

Calling interfaces are documented in the source code of each routine (FTBP
file).
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Standard (non-MultiVValue) File Upload

Upload transfers afile (or files) from your computer to a remote machine.
Uploads may use any of the supported protocols. Usually, to perform afile
upload, you would first start the receiving (download) program on the
remote computer from normal terminal emulation mode. Then after the
remote receiving program has been started, select Tools Upload, select the
appropriate protocol, select the file(s) to upload, then click theUpload
button.

File Selection

Click the Browse button to select the file(s) to upload. If the currently
selected protocol isKermit, Ymodem, or Zmodem, you can select multiple
files, otherwise select only asinglefile.

Protocol

Select the protocol you want to useto upload the selected file(s) by clicking
the appropriate option button: ASCI 1, Kermit, Xmodem, Y modem or
Zmodem.

The ASCI1 protocol by its nature has no error checking. This protocol
should only be used when thereis alocal, error free connection, and when
the remote system does not support any of the other protocols. TheASCI|
protocol only sends text files, and it isnot a“batch” protocol - you can only
send onefile. Youcan adjust the line termination toCR, LF or CR LF by
selecting the desired option in theFile Transfer tab of the Settings dialog
box (T ools Settings menu). You can also set the inter-line delay timein the
same tab (thisis theamount of time AccuTerm waits between lines when
sending afile).

The Kermit protocol provides error detectionand correction. Kermitisa
“batch” protocol, so you can send multiple files. Kermit can send either
text or binary files; text files are converted to the format required on the
receiving machine. Kermit is slower than X/Y/Zmodem, but is the most
portable protocol. It often succeeds when the other protocolsfail. Several
options may be set in theFile Transfer tab of the Settings dialog box.

94 File Transfer



These include the retry limit, timeout period, end of line character, eighth bit
guoting, data compression and block check type (checksum or CRC).

Xmodem is a binary protocol which includes error checking. Xmodem is
not a“batch” protocol; you can only send one file using Xmodem, and you
need to specify the file name to the receiving program. Files transferred
using Xmodem “grow” to the next multiple of 128 bytes. TheXmodem
protocol requires an 8-bit data path, and full 8-bit transparency (you cannot
use Xon/Xoff handshaking when using Xmodem). Y ou can set the
Xmodem timeout period in the File Transfer tab of the Settings dialog
box.

Ymodem is abinary protocol which includes checksum or CRC error
checking. Ymodem isavailablein several “flavors’; the “flavor” used by
AccuTerm is Ymodem-G (1K blocks, batch mode). TheY modem protocol
requires an 8-bit data path, and full 8-bit transparency (you cannot use
Xon/Xoff handshaking when using Y modem). Y ou can set the Ymodem
timeout period in the File Transfer tab of the Settings dialog box.

Zmodem is a sophisticated file transfer protocol which is popular on PCs
and Unix based minicomputers. Zmodem provides robust CRC error
checking, several options for dealing with existing filesand text file
conversion. If the receiving machine usesthe “rz” program, AccuTerm will
send the “rz” command before sending files, to automatically invoke the
receiver’'sZmodem program. The Zmodem protocol requires an 8-bit data
path, but full 8-bit transparency is not normally required (you can use
Xon/Xoff handshaking when usingZmodem). Y ou can set theZmodem
timeout period in theFile Transfer tab of the Settings dialog box.

Mode

When the currently selected protocol isK ermit or Zmodem, you can sdlect
the transfer mode astext or binary. When text modeis selected the line
termination is adjusted to match that of the receiving machine. When
binary modeis selected, the files are transferred without alteration The
ASCI|I protocol aways transfers text files, and Xmodem and Y modem
always transfer in binary mode.

Overwrite

When the Zmodem protocol is selected, the sender can select how to deal
with existing files by selecting anOverwrite mode. Select never if you
want to preserve al existing files Select alwaysto overwrite existing files.
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Append will append onto existing files. Thenewer option replaces existing
files only if the file being sent is newer than the existing file. The update
option overwrites existing files; non-existing files are not transferred. Use
the resume option for crash recovery after aborted transfers- if afile does
not exist on the receiving machine, it is sent; if afileexists, but it is shorter
than the file on the sending machine, the remainder of the fileis sent; if a
file exists, but it is the same length or longer, it is skipped. Note: the
resume option may only be used if the transfer mode is binary.
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Standard (non-MultiValue) File Download

Download transfers afile (or files) from a remote machine to your
computer. Downloads may use any of the supported protocols. Usually, to
perform afile download, you would start the sending program on tie remote
machine while in normal terminal emulation mode. Then after the remote
sending program has been started, select Tools Download, select the
appropriate protocol, select the destination directory (and file name if using
ASCII or Xmodem), then click the Down|oad button.

Directory and File Selection

Click the Browse button to select the destination directory. If the currently
selected protocol iSASCII or Xmodem, then you also need to specify afile
name for the downloaded file.

Protocol

Select the protocol you want to use to download the selected file by clicking
the appropriate option button: ASCI 1, Kermit, Xmodem, Y modem or
Zmodem. For details about each of the protocols, see the discussion in the
previous section.

Mode

When the protocol is set to ASCI I, the modeistext; when it is set to
Xmodem or Y modem, the mode isbinary. When using Kermit, you can
select either text or binary mode. The mode for Zmodem transfersis
determined by the sender.

When text mode is selected lines are terminated with CR/LF. When binary
mode is selected, the files are transferred without alteration.

Overwrite

Check this box to allow existing filesto be overwritten. Note: Kermit and
Ymodem always overwrite. When Zmodem is selected, the sender controls
the action to take if a file exists.
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DATA CAPTURE

AccuTerm is capable of capturing to afile any data received by the your
computer, or any data which would normally be printed to the “ slave”
printer. To start data capture, select Tools from the main menu, then select

the Captur e option or click the| )| button on the toolbar. Select the

capture file and options in the Begin Capturedialog.

CapturetoFile
Enter the capture file namein thisfield, or click theBr owse button to select
the folder and file.

Mode

Select New file only, Overwrite, Append, or Clipboard by clicking the
appropriate option button. If you select Overwrite or Append and the file
does not exist, AccuTerm will create the file. If you selectNew file only
and the file does exist, awarning will be displayed.

Source

Select the data source to be captured asReceived dataor Printed data. If
Received datais selected, all datareceived by AccuTerm (except when a
file transfer is occurring) will be captured to the specified file. This
includes all control characters. If Printed datais selected, al datawhich
would normally be printed to the slave printer port is captured to the
selected file, and not printed.

Filter
Select the Text only (strip control codes) option if you want control
characters filtered out of the captured data.
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Terminating Data Capture
If data captureis already in effect (asindicated in the status bar), selecting

Tools Capture or clicking the| ) | button on the toolbar will display the

End Capturediaog. Click the End Captur e button to terminate the
capture operation, or click the Continue button to resume capturing.
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M ACRO RECORDER

AccuTerm 2K 2 includesa powerful M acro Recorder which can be used to
record a sequence of actions asaVBA macro. AccuTerm’s Macro Recorder
records most menu or toolbar actions, changes to settings and preferences,
and interaction with the host. The recorded macro can be edited, and you
can attach a shortcut key to any recorded macro for instant execution of the
recorded macro.

Recording a Macro

To start recording a new macro, select Record New M acr o from the

M acr o sub-menu under the Tools menu. The M acr o Recor der toolbar will
be displayed near the lower-right corner of the AccuTerm window. When
you are finished recording the macro, click theEl button on the M acr o

Recorder toolbar. Y ou can temporarily suspend recording by clickirg the
button on the M acr o Recor der toolbar. To resume recording, click the

button.

When you are finished recording a macro, the Save M acr o dialog will be
displayed. Here you can give your recorded macro a name (up to 32
characters: letters, numbers or underscore characters only, beginning with a
letter), a short description (up to 32 characters) which is displayed in the
Tools Macro Run Macr o sub-menu, a detailed description and a shortcut

key.

The recorded macro is saved in the AccuTerm Macr osscript file when you
click the Save button. If you do not have a macro script file open yet, you
will be prompted to select the file name for your macro file. Whenyou start
AccuTerm, the macro script file (if it exists) is automatically loaded.

Macros are recorded as a sequence of Visual Basic for Applications (VBA)
Statements.

RunningaMacro

To run amacro, select the desired macro from theRun M acr o sub-menu of
the Tools Macro menu. Alternatively, if the macro has a shortcut key
assigned to it, simply press the shortcut key combination to run the macro.
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EditingaMacro
Y ou can edit your recorded macros by selecting Edit from the Tools Macro

menu. The macro script will be displayed in the Macrostab (2) of the
AccuTerm Script window. Macros are written using the Visual Basic for
Applications (VBA) language. See the Scripting section of the
Programmer s Guidefor moreinformation on VBA scripts.
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WED EDITOR

AccuTerm 2K2 MultiValue Edition includes a handy Windows based
program / data editor for use with your MultiValue host computer. WED is
invoked just like the traditional ED verb, but opens the specified documents
in aWindows full-screen editor. If you specify multiple itemIDs, each item
is opened in its own window. The windows can be arranged, cascaded, or
tiled. Y ou can cut, copy and paste text between documents and other
Windows applications.

When you edit BASIC programsusing WED, wED highlights various
BASIC syntax elementsin different colors and text styles for easy
recognition. Y ou can even customize the color and text style used for
highlighting, specify you own language keyword list and create a user
defined keyword list. WED understands GOTO, GOSUB, CALL and INCLUDE
statements, and allows you to easily jump to the target of the statement.

Advanced editing features include block comment / uncomment, block
indent / outdent, and a built-in BASIC code formatter. One-click compileis
also included.

WED isinstalled when you install the MultiVValue Host Programs (seeFile
Transfer chapter).

To customize wED, open the T ools menu and select General, Highlight or
Tools. Complete online help isincluded.
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Using wED

The wED main window uses Windows “multiple document interface” to
display one or more document windows. Each document can be accessed by
clicking anywhere on the document window or by selecting the desired
document from the Window menu. Y ou can activate to the “next” document
by pressing CTRL + TAB or CTRL + F6. The top area of the main window
may contain atoolbar, and the bottom area may contain a status bar. These
items may be selected from theView menu by checking Toolbar or Status
Bar items.

To create anew document, choose New from the File menu or click the

button on the toolbar.

To open an existing document, choose Open from the File menu or click the
button on the toolbar. The Open dialog is customized for use with
MultiValue systems. If you started wED from a TCL command prompt, or
from the wED menu item or toolbar button in AccuTerm, you will be able to

browse for the file and item you want to open. Y ou can browse for files on
either the host or local Windows file system.

When wED is open, you can use Windows drag-and-drop to open files from

the local Windows file system. Just drag atext file from Windows Explorer

and drop it on the WED menubar. Similarly, you can create a shortcut to the
main WED program (atwed32.exe) in your “Send To” folder to add wED as
a“Send To” target in the Explorer context menu.

To save the current document, choose Save from the File menu or click the
button on the toolbar. The Save dialog is customized for MultiValue

systems and has the same browsing features as theOpen dialog.

To save all open documents, choose Save All from the File menu or click
the button on the toolbar.

To print the active document, choosePrint from the File menu or click the
button on the toolbar.
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Editing a Document using WED

The Document window contains the text of the document being edited. The
text is displayed with aline number in the left margin, and may be
highlighted by color and text style according to BASIC language syntax
rules.

The document is edited using a freeform text editor, and fully supports
standard Windows commands.

Typing Text

If any text is currently selected, typing text replaces the selection. If no text
is selected, typing inserts at the current cursor position. PresSENTER to
begin anew line. To insart a system delimiter (value-mark or sub-value-

mark) into the document, pressCTRL + ] or click the button for a

value-mark; pressCTRL + \ or click thelzl button for a sub-value-mark.

Cursor Movement

Move the cursor by pressing any cursor movement key (UP, DOWN, LEFT,
RIGHT, HOME, END, PAGEUP, PAGEDOWN). Holding the CTRL key when
pressing another cursor key modifies the cursor key action as follows: CTRL
+ RIGHT moves forward one word, CTRL + LEFT moves backward one
word, CTRL + HOME moves to the beginning of the document, CTRL + END
moves to the end of the document.

Selecting Text

Y ou can select text either by using the mouse (click and drag), or from the
keyboard. To select text from the keyboard, hold theSHIFT key while
moving the cursor (UP, DOWN, LEFT, RIGHT, HOME, END, PAGEUP,
PAGEDOWN). The SHIFT and CTRL keys can be used together; for example,
CTRL + SHIFT + RIGHT selects the next word. PressCTRL + A to select the
entire document.

Indenting Text
Press the TAB key to indent text, beginning at the current cursor position, to
the next tab stop. If multiple lines are selected, pressingTAB or clicking the

button indents all selected lines (at the beginning of the line); pressing

SHIFT + TAB or clicking the[£=| button outdents all selected lines.
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Clipboard
To copy text to the clipboard, select the desired text and pressCTRL + C or

click the|Egj| button. To copy to the clipboard and del ete selected text (cut),

pressCTRL + X or click the button. To paste text from the clipboard,
pressCTRL + V or click the button.

Deleting Text
To delete text, select the desired text and press theDELETE key or click the

button on the toolbar. If no text is selected, pressing theDELETE key

erases the character to the right of the cursor. Press theBACKSPACE key to
erase the character to the left of the cursor. PressCTRL + Y to delete the
entire line that the cursor is on.

Searching
To search for text in the document, pressCTRL + F or click the|gf | button

on the toolbar. Enter the text you are looking for. Select the appropriate
options (whole word, match case, direction) and click the Find Next button.

To repeat the last search, press theF3s key or click the| #, | toolbar button. If

you pass the end of the document and begin searching from the top, you will
hear a beep, and amessage will be displayed in the status bar (Find Again

only).

Replacing Text

To search and replace text, pressCTRL + H. Enter the text to search for and
the replacement text. Select the appropriate options (whole word, match
case) and click Find Next, Replace or Replace All.

Changing Case
To change the case of the selected text, select Toggle Case from the Tools
menu or click the|fiRa| button on the toolbar. Each time the Toggle Case

button is clicked, the case of the selected text is changed from its current
form to Upper Case, Lower Case and Proper Case, in that order.

Commenting and Uncommenting Text
If you have ablock of text selected, you can “comment out” the whole block

by selecting Comment from the Edit menu or clicking the| = | button on

the toolbar. An asterisk (*) will be inserted at the beginning of each linein
the selection. To "un comment" a block, select Uncomment from the Edit
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menu or click the button. The leading asterisk (*) of each linein the
block will be deleted.

Undoing Changes
PressCTRL + Z or click the button to undo the last editing operation.

Redoing Changes
Select Redo from the Edit menu or click the| ca | button to redo the last
operation which was un-done.

Goto
Click the| # | button or select Goto from the Edit menu to open the Goto
dialog box. Enter aline number or choose a statement label to jump to.

Context Menu

If you click the right mouse button anywhere in the document window, a
context (pop-up) menu is displayed. From the context menu, you can select
Undo, Cut, Copy, Paste, Clear (delete), Select All, Find, Find Next,
Replace, Open, Goto and Highlight. Some context menu choices may not
be available depending on the location clicked and the state of the clipboard.
For example, the Goto option is only enabled if you right-click on alabel
following a Goto or Gosub statement, and Open is only availableif you
right-click on a program name after an Include or Call statement.

Double-clicking on a statement label following aGoto or Gosub statement
works the same as sel ecting Goto from the context menu. Double-clicking
on a program name following an Include or Call statement works the same
as selecting Open from the context menu.

Formatting BASIC Source Code
Select the For mat option from the Tools menu or click the| = | button on

the toolbar to format the document as BASIC source code. The margin and
indentation sizes are specified in the Toolstab of the WED settings, which
can be selected by choosng Tools from the Options menu.

Compiling BASIC Code
Select the Compile option from the Tools menu or click the| # | button to

compile the document (program). The results of the compile operation are
displayed in the Resultswindow. If a compilation error occurred, double
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click the error line in the Results window to position the cursor at the
offending line in the source code. The compiler command and options are
specified in the Toolstab of the WED settings, which can be selected by
choosing Tools from the Options menu.

Syntax Highlighting

WED is able to parse BASIC language elements in the document and
highlight various elements using a variety of colors and text styles. To
enable or disable syntax highlighting, select Highlight from the View menu

or from the context menu, or click the £| toolbar button. To specify

custom colors, styles, language and user keywords, selectHighlight from
the Options menu.

Document Properties

Y ou display the properties of the currently active document by selecting
Document Propertiesfrom the File menu or pressing CTRL + L. Properties
displayed include the document file and item name, current size, number of
lines, selection size, and number of lines selected.

Results Window

Y ou can open the Results window by selecting Results from the View
menu. Thiswindow displays the results of the last compile operation.
Double-clicking on an error line number will position the cursor onthat line
(in the current document).
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APPENDIX A

ASCII| Codes

ASCII Decima  Hex ASCI| Decimal  Hex
NUL 0 00 SPACE 32 20
SOH 1 01 ! 33 21
STX 2 02 " 34 22
ETX 3 03 # 35 23
EOT 4 04 $ 36 24
ENQ 5 05 % 37 25
ACK 6 06 & 38 26
BEL 7 07 ! 39 27
BS 8 08 ( 40 28
HT 9 09 ) 41 29
LF 10 0A * 42 2A
VT 11 0B + 43 2B
FF 12 oC , 44 2C
CR 13 oD - 45 2D
SO 14 OE . 46 2E
Sl 15 OF / 47 2F
DLE 16 10 0 48 30
DC1 17 11 1 49 31
DC2 18 12 2 50 32
DC3 19 13 3 51 33
DC4 20 14 4 52 34
NAK 21 15 5 53 35
SYN 22 16 6 54 36
ETB 23 17 7 55 37
CAN 24 18 8 56 38
EM 25 19 9 57 39
SUB 26 1A : 58 3A
ESC 27 1B ; 59 3B
FS 28 1C < 60 3C
GS 29 1D = 61 3D
RS 30 1E > 62 3E
us 31 1F ? 63 3F
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ASCII Codes (continued)

/

@ 64 40 9 60
A 65 4 a 97 61
B 66 42 b 08 62
C 67 43 C 99 63
D 68 a4 d 100 64
E 69 45 e 101 65
F 70 46 f 102 66
G 71 47 g 103 67
H 72 48 h 104 68
I 73 49 i 105 69
J 74 4A j 106 6A
K 75 4B k 107 6B
L 76 4C 1 108 6C
M 77 4D m 109 6D
N 78 4E h 110 6E
0 79 4F 0 111 6F
p 80 50 p 112 70
Q 81 51 q 113 71
R 82 52 r 114 72
S 83 53 s 115 73
T 84 54 t 116 74
u 85 55 u 117 75
Y 86 56 v 118 76
W 87 57 w 119 77
X 88 58 X 120 78
Y 89 59 y 121 79
z 9 5A z 122 7A
[ 91 58 { 123 7B
\ 92 5C | 124 7C
] 93 5D } 125 7D
A 94 5E ~ 126 7E
_ 95 5F DEL 127 7F
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ASCII Codes (continued)

128 80 160 A0

129 81 i 161 Al

130 82 ¢ 162 A2

131 83 £ 163 A3
IND 132 84 X 164 A4
NEL 133 85 ¥ 165 A5
SSA 134 86 ! 166 A6
ESA 135 87 § 167 A7
HTS 136 88 " 168 A8
HTJ 137 89 © 169 A9
VTS 138 8A a 170 AA
PLD 139 8B « 171 AB
PLU 140 8C - 172 AC
RI 141 8D 173 AD
ss2 142 8E ® 174 AE
ss3 143 8F - 175 AF
DCS 144 90 ° 176 BO
PUL 145 a1 + 177 B1
PU2 146 92 2 178 B2
sTS 147 93 3 179 B3
CCH 148 94 - 180 B4
MW 149 95 H 181 B5
SPA 150 96 1 182 B6
EPA 151 97 . 183 B7

152 98 . 184 B8

153 99 1 185 B9

154 9A o 186 BA
csl 155 9B » 187 BB
ST 156 9C Y% 188 BC
osc 157 9D % 189 BD
PM 158 9E % 190 BE
APC 159 oF ] 191 BF
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ASCII Codes (continued)

A 192 Co a 224 EO
A 193 C1 a 225 El
A 194 C2 a 226 E2
A 195 C3 a 227 E3
A 196 C4 a 228 E4
A 197 C5 a 229 E5
.3 198 C6 & 230 E6
C 199 C7 c 231 E7
E 200 C8 e 232 E8
E 201 C9 é 233 E9
E 202 CA é 234 EA
E 203 CB é 235 EB
I 204 CC i 236 EC
I 205 CD i 237 ED
I 206 CE i 238 EE
I 207 CF i 239 EF
b 208 DO 0 240 FO
N 209 D1 f 241 F1
0 210 D2 0 242 F2
0 211 D3 6 243 F3
0 212 D4 0 244 F4
0 213 D5 0 245 F5
0 214 D6 6 246 F6
X 215 D7 + 247 F7
7] 216 D8 4] 248 F8
] 217 D9 u 249 F9
1] 218 DA u 250 FA
0 219 DB a 251 FB
] 220 DC u 252 FC
Y 221 DD y 253 FD
b 222 DE b 254 FE
R 223 DF y 255 FF
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Access, 87
ActiveX, 1
AES, 37
ANSI Options, 46
Answerback, 50
ASCII, 98
ASCII Codes, 113
ASCII Settings, 64
Auto Answer, 31
Auto close, 28
Auto Closeg, 25
Auto Dialer, 69
Auto print, 46
auxiliary port, 103
Baud Rate, 29
Beep, 67
Bell sound, 67
binary mode, 99, 101
Blinking, 49
Blowfish, 37
CapsLock, 59
Capture Source, 103
checksum, 65
color, 53
Colors

border style, 56

line drawing, 56

protected attribute, 56

schemes, 54
visual styles, 55

Communication Errors, 28
Communications Device, 27
Communications Port, 29
Connection Method, 27

Connection Settings
Serid Port, 29
Connection Type, 27

Connection Wizard, 10

control codes, 1
CRC, 65
Cursor shape, 49
DataBits, 29
data capture
starting, 103
Data Capture, 103
data compression, 65
Database files, 83
dBase, 87
Default capture directory, 24
Default download directory, 24,
65
default phone book, 24
default transfer mode, 65
Default upload directory, 24, 65
Delimited files, 83
DES, 37
Device, 27
dial, 69
Dialing Options, 31
Download, 71, 101
DSA, 39
DTR/DSR, 30
Duplex, 27
Edit Menu, 13
Editing macros, 17
eighth bit
guoting, 65
stripping, 27
email, 63
Encryption, 3
error checking
checksum, 65
CRC, 65
error detection, 98
escape sequences, 1
Euro, 52

Index
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evaluation version, 9
Excel, 83, 85, 87
existing files, 100, 101
Exporting files, 83
extended mode, 47
Extended Mode, 49
fax, 63
File Menu, 12
File Selection, 98, 101
File Transfer, 71
file transfer protocol
ASCII, 71
Kermit, 71
Xmodem, 71
Y modem, 71
Zmodem, 71
file transfer protocol options, 64
File transfer, Direct Pick-to-Pick
transfer, 91
File transfer, DOS file to Pick
file, 85
File transfer, Download, 78
File transfer, File formats, 87
File transfer, FT options, 81
File transfer, FTD options, 89
File transfer, FTD utility, 83
File transfer, FTPICK options, 94
File transfer, FTPICK utility, 91
File transfer, Importing data, 85
File transfer, Indirect Pick-to-
Pick transfer, 92
fingerprint, 41
Font, 51
character set, 52
Euro character, 52
legible, 52
scaling, 51
size, 51
style, 51
function key programming, 58
garbled data, 32
Graphic Mode
enabling, 49

Handshake, 29
Hangup, 69
Hardware Requirements, 4
Help, 19
Help Menu, 19
History, 20
History buffer, 48
History Rows, 48
host integration, 1
Host programs
installation, 72
Host Terminal Type, 45
HTML table, 87
Icon, 47
Importing akey, 41
Importing files, 85
Installation, 7
inter-line delay, 98
Internet Explorer, 3
Kermit, 76, 98
Kermit Settings, 65
Keyboard
key caption, 59
key code, 58
Keyboard Commands, 20
layout file, 11
lineend
ASCII, 64
Line Wrap, 49
Lotus, 87
Macro Recorder, 105
Macros, 17
MDlI, 1, 10
Modem, 31
Mouse
enabling, 49
mouse wheel, 48
Multinational character set, 46
Multiple Document Interface, 1,
10
MultiValue host programs
installation, 72
MultiValue Host Programs
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activating other accounts, 75
MultiValue server, 17
Network Installation, 9
normal mode, 47
OLE, 1
OpenSSH, 39
Parity, 29
Paste, 64
Paste Options

line end, 67

paste end, 67
PCL, 63
PDFfiles, 63
Personal Edition, 10
Phone book, 24
phone book file, 24
Phone directory, 69
phone directory file, 70
Pick host programs

installation, 72
Pick Host Programs

activating other accounts, 75
PicLan, 42

Host, 42

Timeout, 42
Port, 29
Print Adapters, 63
Printer

job close timeout, 63
Printer Selection, 62
PrintWizard, 63
Programmers Guide, 1
Protocol, 98, 101
Recording a macro, 17
Reset Menu, 18
RSA, 39
RTS/CTS, 30
Running a macro, 17
Screen Print, 62
Screen Sizes, 47
scripting, 1
Scripting language, 2
scroll bars, 47

Scrollback, 20, 48
Secure Shell, 3
Authentication, 37
Break character, 37
Host, 36
IP address, 36
Keepalive, 38
Key, 37
Key Management, 39
Options, 37
Outbound coalescing, 38
Port, 36
Preferred Cipher, 37
SSH version, 37
Terminal Type, 45
Timeout, 36
U2 Device Licensing, 38
selection, 13
serial number, 19
Session Title, 47
Settings
Colors, 53
Connection, 27
File Transfer, 64
Font, 51
General, 24
Keyboard, 57
Miscellaneous, 67
Printer, 61
Screen, 47
Terminal Type, 43
Shortcut, 11
Shortcut keys, 60
Single instance, 25
dave printer, 103
Slave Printer, 62
Software Handshake, 30
Software Requirements, 4
Spreadsheet files, 83
ssh, 36
start capturing, 103
Status Line, 45
Stop Bits, 29
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Strip Eighth Bit, 27 text mode, 99, 101

System Requirements, 4 Timeout, X/Y/Zmodem, 64
TAPI, 31 Title format, 24
TCL Rules, 17 Tools Menu, 15
TCP/IP, 33, 36 Underline, 49
TCP/IP hostsfile, 24 Upload, 71
Telnet, 33 VBA, 2,105
Alternate break option, 34 Video Pages, 48
Binary option, 34 View Menu, 14
Bypass option, 34 visual attributes, 53
Connect Timeout, 33 visual styles, 55
Echo option, 34 WED Editor, 107
Host Name, 33 wheel mouse, 48
Host Type, 33 Window Menu, 18
IP address, 33 Wrapping, 49
Keepalive, 35 Xmodem, 98
Options, 34 Xon/Xoff, 30
Outbound coalescing, 35 Y modem, 98
Port, 33 Zmodem, 98
Terminal Type, 45 crash recovery, 100
U2 Device Licensing, 35 Zmodem, automatic download,
Terminal Emulation, 43 66
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